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Introduction
      Introduction

Web ATIDS Overview
Automated Title Information Data System (ATIDS) is Florida’s largest database of 
geographically posted title information. It is maintained and made available by The 
Fund. It consists of more than 900 million property records from nearly 40 of the 
state’s most active counties, including property tax information in many of the largest 
counties. Over 26,000 new records are added daily.

Web ATIDS provides a Web browser-based front end to ATIDS through the Internet. 
Easy to learn and use, Web ATIDS was created by The Fund and is designed for use in 
a Microsoft Windows® environment. 

Note: The Help Desk may be reached at 1-800-421-9378 from 8:00 AM to 6:30 PM, 
Monday through Friday, or by e-mailing your question(s) to the Help Desk at 
helpdesk@thefund.com.

About This Workbook
The Web ATIDS I Basic Training course is designed to assist in the use of the system 
to access property, name, and tax information in preparation for title examination.
This student workbook is designed for individuals with title examination knowledge 
and experience, as well as a basic knowledge of Windows. 
Each lesson has three sections:

Concept: The concept explains the purpose of the module and its relationship to 
the gathering of title information for examination purposes. 

Objective:The objective for each lesson is the particular task or set of tasks you 
will learn. 

Lesson: Lessons are step-by-step instructions designed to walk you through the 
module. They provide hands-on experience using Web ATIDS.

In addition to the regular lessons, practice sessions are included. The practice sessions 
are given where additional hands-on experience might be helpful. The practice 
sessions may be covered in the class, if time permits, or you may work on them at your 
office.
This Workbook was produced by Team Educat!on at The Fund. Team Educat!on 
serves The Fund’s mission by providing exceptional education, training and support 
needed to develop real estate professionals’ knowledge, skills, and abilities. You may 
contact this unit by phone at 888-407-7775 or by e-mail at 
educationregistrar@thefund.com. The Member Support Representatives who provide 
hands-on training for the Web ATIDS application are part of Team Educat!on. 
Training Workbook Version: 081711 Page 1



Introduction
“The Fund” is a registered trademark of Attorneys’ Title Insurance Fund, Inc. and is 
used by permission. All references herein to title insurance policy forms and 
endorsements refer to the policy forms and endorsements issued by Fund Members as 
duly appointed title agents of Old Republic National Title Insurance Company. 

Conventions
The following conventions are used in this workbook. 

Convention Meaning

Bold characters Text that identifies all or part of a Web ATIDS window or 
instructs you to type information is represented by Arial font 
in bold. All other text is Times New Roman.

Choose Pick an item (button or a menu item) to initiate an action. 
Windows supports more than one method to accomplish an 
action. For example, you could click a specific button and press 
ENTER. Choose is used when the method is not important for 
the discussion.

Click Use the mouse to position the pointer over a button in a dialog 
box, then press and release the left mouse button. For example, 
“click OK” means position the pointer over the OK button, then 
press and release the left mouse button.

Key names The names of keys with special functions that you press on the 
keyboard are in all CAPITAL letters. For example, use the TAB
key to move to the DATE boxes/fields and type 3/22/08. 

Select Pick one or more items for processing. For example, select the 
name(s) from the list.
Page 2 Web ATIDS Ver. 3.2



Introduction
Windows Terms
The following figure shows a typical Web ATIDS window with the terms used in this 
guide.

Title Bar

Hyperlinks 

Option Buttons 

Option Boxes/Fields

Drop Down Boxes 

Check Boxes

Term Function

Title Bar Displays the Web ATIDS name and the name of the active 
closing file.

Option Buttons Displays buttons used to select Web ATIDS functions.

Option Boxes and Fields Option Boxes and Fields are areas where you can select or type 
information. Only Boxes and Fields with a white background 
can be changed. Information that is displayed in gray boxes 
cannot be changed in the active area.

Drop Down Boxes Drop Down Boxes displays a list of available options. 

Hyper-links Hyper-links direct you to additional functions or resources 
within the application.
Training Workbook Version: 081711 Page 3



Introduction
Windows Shortcut
A useful Windows shortcut to remember while working in Web ATIDS is to press ALT 
+ TAB to switch between Web ATIDS and another open Windows application on your 
desktop.

General Information
Internet Access. High-speed or broadband Internet connectivity (via DSL, ISDN, 
Frame Relay, T1 line, Cable, etc.) is highly recommended for use with Web ATIDS.
Supported Versions of Windows. Web ATIDS requires Windows XP Professional, SP2 
32-bit, Microsoft Windows Vista 32-bit and 64-bit, or Microsoft Windows 7 32-bit and 
64-bit. For Windows upgrade assistance, please contact your network administrator or 
computer professional.
Required Versions of Internet Explorer. For best results when accessing The Fund’s 
website, your version of Internet Explorer must be 6.0, 7.0, 8.0 or Netscape Navigator 
7.0. To check your I.E. version, select Help from the main menu bar, and select About 
Internet Explorer. If you need to update your version, please visit Microsoft’s site 
(http://www.microsoft.com/windows/ie/default.asp) where you can download an 
update. For update assistance with Internet Explorer, please contact your network 
administrator or computer professional.

Term Function

Option Buttons Use an option button to select a single item from a group of 
items. To select an option, click the circle next to it. A black dot 
appears in the circle. 

Check Boxes Use a check box to select one or more items in a group. To 
select an item, click the box next to it. A check mark is 
displayed in the box. To clear a check box, click it again.

Tool Tip The Tool Tip displays information about the program. For 
example, as you move the mouse pointer over the buttons, a 
description of the button is displayed.
Page 4 Web ATIDS Ver. 3.2



Introduction
The Fund’s Website
The Fund provides support for members via its website www.thefund.com. This is 
your source for Fund products and services, as well as information relevant to a real 
estate law practice. The Product Support section can be accessed for technical support, 
product updates, and the latest news for select Fund products. Simply click Support & 
Downloads in the top navigation bar, and then click ATIDS Customer Support from 
the list of products.

Note: To email The Fund with questions or suggestions on ATIDS, click the e-mail link 
just below Welcome to the ATIDS Customer Support Page, or click Ask a Support 
Question via Email link in the left navigation bar.
Training Workbook Version: 081711 Page 5



Introduction
Logging Onto Web ATIDS
What You Do Comments

1. Open your internet 
browser, and type the URL 
for The Fund 
(www.thefund.com)

The first step in accessing the Web ATIDS 
system is entering the URL for Web ATIDS 
on the Internet browser. Note: The Fund’s 
website portal contains a public portion and a 
private portion accessible only to website 
users who have a User ID and Password. 
Some informational pages about Web ATIDS 
are located on the public portion of the 
website. However, to access most of the 
information about Web ATIDS a valid User 
ID and Password are required. In addition, to 
launch and use the Web ATIDS application 
itself, the user’s firm must have a Fund 
enabled account, and the user must have been 
granted Web ATIDS privileges by the firm’s 
FundNet Administrator. 

2. This will display the 
Welcome to The Fund 
screen
Page 6 Web ATIDS Ver. 3.2



Introduction
3. Enter the User ID and 
Password and click on the 
Login button.

This logs you into the password protected area 
of The Fund’s website, and enables access to 
the Web ATIDS application (provided your 
firm and you have a Web ATIDS account)

, Keep your password confidential. If your computer will be 
unattended, always log off to prevent unauthorized access to the 
system.

4. Select Launch Web 
ATIDS from the FundNet 
(Members only) options on 
the left of the screen.

5. The Launch Web ATIDS
screen will display. 

This screen will display important Web 
ATIDS messages when necessary.

What You Do Comments
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Introduction
6. Click on the Launch Web 
ATIDS button. 

The Main Menu is displayed.

What You Do Comments
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Introduction
Main Menu
The Main Menu is organized into six major thematic categories:

• File Search and Order
• Billing Activity
• County Information
• Subdivision/Condo Details
• Miscellaneous
• Replat/Underlying Information

Each of the six major categories contains a list of subcategories of menus describing 
the functions that can be performed in Web ATIDS. To select a subcategory, click the 
appropriate button. Note: For a brief description of each function, move the mouse 
pointer over the button.

7. Move the mouse pointer 
over the clickable buttons 
appearing on the Main 
Menu.

A brief description of the function available 
within Web ATIDS that will be launched if 
you click the button appears when you move 
the mouse pointer over the button.

What You Do Comments
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Lesson 1 - The Basics
Lesson 1 - The Basics

Concept
In this lesson you will use transactional information to perform searches using Web 
ATIDS. This lesson assumes that a Web ATIDS user already has the required property 
information needed to perform the search (for example, a complete and accurate legal 
description and base title information). 

Objective
With a complete and accurate legal description and base title information in hand, you 
will learn the following steps, which are part of the process of title examination in a 
routine real estate closing transaction. You will learn how to:

• Open a Web ATIDS file
• Perform a property search on the legal description
• Perform name searches - personal and commercial
• Order hard copies of documents
• Receive orders via ProPel.
• Perform a property update search
• Perform a name update search
• Rate the owner's and mortgagee policies.

Transaction Information 
Training Workbook Version: 081711 Page 11



Lesson 1 - The Basics
The contract information necessary for this lesson is shown above. In addition, we 
have learned that there is a prior owner’s title insurance policy acceptable for use as 
base title bearing an effective date of June 15, 2000. This date will be used as the 
Search From Date.   

Using The Search Menu To Add A New File 
What You Do Comments

1. From the Main Menu, 
click the Search Menu
button.

The Search Menu screen is displayed.

Note: The Add/Change/Find File
transaction is used to add an ATIDS file. A 
separate ATIDS file number must be added 
for each new closing transaction. The proper 
Bill Code must be assigned to the file in this 
transaction. The Add/Change/Find File
transaction also allows the change of certain 
file related information and the scan of files in 
the ATIDS account.
Page 12 Web ATIDS Ver. 3.2



Lesson 1 - The Basics
2. Choose the Delivery 
Options you want for the 
file. 

To obtain a printout, select Print Search 
Results. To also store the documents in the 
Order Documents transaction, also select 
Sent to Document Order Queue. To send 
the search results to ProPel, select Send to 
ProPel Queue. To display the search results 
within the current Web ATIDS session, 
including real time image viewing, select 
Display Search Results. Note: The 
Delivery Options field defaults to Print 
Search Results and Send to Document 
Order Queue. Choosing Display Search 
Results deselects the default selections. 

3. In the County field, select 
Palm Beach county.

This transaction involved property located in 
Palm Beach County. Note: When signing-on, 
the system defaults to your home county.

4. In the File Name/No.
field, type the file name/
number for this transaction.

Note: The File Name/No. can be up to 15 
characters, digits, or a combination of 
characters and digits.

5. Click the Add/Change 
Find File button.

The Add/Change/Find Files screen is 
displayed.

What You Do Comments
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Lesson 1 - The Basics
6. Click the Add/Change/
Find File button.

The Add/Change/Find Files screen is 
displayed.

7. Verify that you have 
entered the correct file 
number. If not you may 
change it before clicking 
the Submit button. 

Note: The Function field defaults to the Add
option. There are 3 options available. The 
Change option is used to change the 
description, Bill Code, or Policy Intent 
question in an existing file. The Find option 
is used to locate an existing file number.

8. Click on the Submit
button.

The next screen needed to add the file 
displays.

What You Do Comments
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Lesson 1 - The Basics
9. In the Ordered By field, 
type the criteria desired 
(i.e. paralegal name, 
attorney name, etc). 

Note: The Ordered By field is a required 
field and will appear on the account's billing 
activity report.

10. Tab to the Description field 
and type LeBlanc To 
Realistat Realty

A description of the file is placed in this field. 
The name of the seller and the buyer will be 
the description for this file. Note: The 
Description field is a required field and will 
appear on the account's billing activity report.

11. Tab to the Bill Code field. The Bill Code selected here determines the 
cost of the file. Note: The Bill Code field 
defaults to Title Search.

12. Confirm the Yes answer to 
the Policy Intent
question.

A Yes answer denotes that there will be an 
ORNTIC/ATFS policy issued. A No answer 
denotes that there will not be an ORNTIC/
ATFS policy issued. Note: The default is set to 
a Yes answer.

13.  Click the Enter/Return 
to Search Menu button.

The Search Menu window displays. The 
file has been added. Note: The File Name/
No. field contains the name of the file that 
was just added. Note: the Submit button will 
re-display the Add/Change/Find Files
window allowing you to enter another file. 

What You Do Comments
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Bill Codes
It is important to use the proper Bill Code when creating your file. Know the purpose 
of the file before you create it in Web ATIDS so that you can choose the Bill Code
that is most appropriate. 

Bill By File Codes - Certified Information

* A TITLE yes file can be extended an additional 6 months at no charge by using the 
Billing Activity Menu transaction. Or, you may call the Help Desk for this request, 
however a $25.00 processing charge will be insured. 
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Lesson 1 - The Basics
Title Special Project Rate Bill Code

• If a file has been added and the cutoff number has been mistakenly omitted, the 
Billing Activity Menu Transaction adjustment screen may be used to add or 
correct the cutoff number.
Training Workbook Version: 081711 Page 17



Lesson 1 - The Basics
ATIDS Title Information Credit/Adjustment Policy
After a customer opens files in ATIDS to order title information, the customer may 
request a credit or adjustment on the charges. The guidelines that The Fund will use to 
adjust a customer's account or to determine what percentage to credit a customer’s 
account are as follows:

Note: (1) Changes to the Bill Code will be adjusted or credited according to the 
standard pricing in effect for the newly selected Bill Code. (2) Adjustments and 
credits will only be granted for files billed within 12 months. (3) Billing 
Activity Menu transaction will allow for Adjustment to the account. If the 
transaction does not grant the adjustment requested, please call the Help Desk.
Page 18 Web ATIDS Ver. 3.2



Lesson 1 - The Basics
Subdivision/Condo Search
What You Do Comments

1. From the Search Menu, 
click on the Subdivision/
Condo Search button.

The Subdivision/Condo Search screen is 
displayed. Note: The Subdivision/Condo 
Search transaction is used to search property 
records for platted legal descriptions such as 
subdivisions and condominiums. This option 
generates a printout of document reference 
information found for a legal description(s) 
searched. Only documents containing legal 
descriptions are obtained from this option. 
Examples of types of documents that may be 
found include deeds, mortgages, assignments, 
and satisfactions of mortgages.
Training Workbook Version: 081711 Page 19



Lesson 1 - The Basics
2. In the Search From 
Date field, type 
06152000

June 15, 2000 is the effective date of the prior 
policy you are using as your base title. Note: 
(1) Depending on base title used, the Search 
From Date can also be one of the following 
dates: the effective date of an exact prior, date 
of plat, or the county on-line date. (2) Leaving 
the Through Date field blank will include 
results through the most recent certified 
through date and time. (3) The Document 
Filter field permits restricting search results 
to pre-defined specific types of documents 
(for example, deeds, easements, liens, 
mortgages, restrictions, satisfactions, 
miscellaneous). 

3. Tab to the Source of Plat
field, and select the source 
of plat accordingly.

The source of plat for La Mancha 2 is a Plat 
Book. Note: The Source of Plat field 
defaults to Plat Book. Other Source of 
Plat Codes are: 
CO Chancery Order
OR Official Records
CB Condominium Plat Book
DB Deed Book
MP Minor Plat Book (Alachua &   
        Hillsborough)
MS Miscellaneous Book
MB Mortgage Book
PU Planned Unit Development (PUD) 
PB Plat Book
RP Road Plat Book
SB Survey Book
UN Unrecorded Plat

4. Tab to the Book field and 
type 29

The Plat Book Number for La Mancha 2 is 29.

5. Tab to the Page field and 
type 196

The Plat Book Page Number for La Mancha 2 
is 196.

6. Tab to the L1 Lot/Unit
field and type 9

Note: L1 (Lot/Unit) is the smallest part of 
your legal description. This would include 
lots, units, tracts, parcels, apartments, weeks, 
etc.

What You Do Comments
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7. Tab to the L2 Block/Bldg
field and type V

Note: L2 (Block/Bldg) is the next largest 
part, if any, of your legal description. This 
would include blocks or buildings.

8. Leave the L3 Sec/Twn/
Rng field blank

Note: L3 (Sec/Twn/Rng) is the largest part, 
if any, of your legal description. This is used 
for a limited number of subdivisions and is 
usually a section-township-range, tier, or unit 
number.

What You Do Comments
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9. Click the Submit button. The property search is performed, and the 
search results window is displayed below. 

What You Do Comments
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Lesson 1 - The Basics
10.  Click the Deliver Search 
Results button. 

The search results are printed and the Search 
Menu is then re-displayed

Note: The RETRO DATA CERTIFIED message is displayed for counties that 
have added retro-converted or complete records for the plat being searched. The 
records cover a period of time immediately before the certified from date. A 
search may be made from the certified date of the retro data. Palm Beach county 
has been retro certified from January 1, 1968.

Note: Use the Plat Information from Plat Reference (TISM) transaction to 
obtain plat information regarding name of plat, date of plat certification, 
authorized levels, whether or not a Title Status Report is available, etc.

What You Do Comments
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Lesson 1 - The Basics
Reading a Certified Web ATIDS Printout
                                               Sample Certified Printout

Printout continued on next page...
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Lesson 1 - The Basics
                                                           Sample Certified Printout

Printout continued on next page...
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                                                               Sample Certified Printout

Printout continued on next page...
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                                                               Sample Certified Printout

Printout continued on next page...
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                                                             Sample Certified Printout

Printout continued on next page...
Page 28 Web ATIDS Ver. 3.2



Lesson 1 - The Basics
                                                            Sample Certified Printout

Printout continued on next page...
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                                                               Sample Certified Printout

Printout continued on next page...
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                                                               Sample Certified Printout
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Lesson 1 - The Basics
How To Read A Web ATIDS Printout

Table 1: 

ATIDS Field Code Meaning
DOF Date of Filing. Month, day, and year the 

document was filed in the public records.

PR Primary Reference. Type of book, book 
number, and page number where the 
document is recorded at the courthouse. In 
several counties, (i.e. Sarasota, Baker, and 
Gilchrist), this is the Official Records 
Instrument number.

SR Secondary Reference. Clerk's file number, for 
documents recorded in the Official Records.

DOI Date of Instrument. Month, day, and year the 
document was executed. If DOI is later than 
DOF, or was unavailable or illegible when the 
document was entered into ATIDS, this field 
displays 01011900.

TOI Type of Instrument. Type of instrument code 
that corresponds as closely as possible to the 
actual type of document. A complete list of 
Type of Instrument codes appears in the 
following table.

DESC Description. Clarifies information in the TOI
field, or contains additional information about 
a document.
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Lesson 1 - The Basics
MIN Mortgage Identification Number. A unique 
number for identifying loans. The MIN comes 
from either the Assignment of Mortgage 
Instruments or the Mortgage Instruments.

1st PARTY Usually the party initiating and signing the 
document; includes marital status if available. 
Example: Seller or grantor on a deed, or 
mortgagor on a mortgage.

2nd PARTY Recipient of the action created by the 
document; includes marital status and type of 
estate, if available. Example: Buyer or grantee 
on a deed, or mortgagee on a mortgage.

AMOUNT Dollar amount. Example: Mortgage amount, 
doc. stamp amount, or lien amount.

NAME Displays scrivener name, collateral name (on 
UCO documents), or other names.

TYPE Mortgage type codes or UCC/UCO financing 
statement type codes.

REFERENCE Recording reference(s). If document is part of 
a case, the case number is referenced. On 
conveyances, the county property tax 
identification number is sometimes provided.

LEGAL Legal description, including subdivision name 
if applicable. If the legal description is too 
long for the field, (INC) at the end indicates 
the description is incomplete. The actual 
document would need to be reviewed in order 
to see the complete legal description.

COMMENTS Special or descriptive information.

Table 1: 

ATIDS Field Code Meaning
Training Workbook Version: 081711 Page 33



Lesson 1 - The Basics
Instruments Indexed by Instrument Numbers 
For those counties where the recorded documents are indexed only by a ten digit 
Official Records Instrument Number and the number of pages the document contains, 
(e.i. 1998020400 9 pgs) will be shown in Web ATIDS as follows: 
The first four digits indicate the year the document was recorded and the following six 
digits identify the individual instrument.

Property Document (Property 
Index)

CN replaces OR for the Primary 
Reference. The Year replaces the Book 
Number. The six-digit Instrument 
Number replaces the Page Number. For 
the Secondary Reference, the six-digit 
Instrument Number replaces the Clerk 
Number.

Name Document (General 
Index)

The Official Instrument Number is only 
entered in the Secondary Reference field. 
There is no entry in the Primary Reference
field.

Note: If you have any questions, please call the Help Desk at 1-800-421-9378

Guidelines for Eliminating Instruments

Property Search Guideline
Instrument Type Comments

Mortgages & Similar 
Encumbrances

For issuing an ORNTIC/ATFS policy, it is not 
necessary to order or review copies of 
mortgages, mortgage-related documents, 
property liens, and other instruments that are 
satisfied of record or unenforceable by statute.

How to Apply This Property Search Guideline
Step Comments

1. Review the property search 
printout.

Note all references to these documents:
• Mortgages, satisfaction/releases of 
mortgages, and mortgage-related documents.
• Property lien documents such as 
construction liens, special assessment liens, 
and satisfaction of liens.
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Replats in Web ATIDS

2. Compare printout entries 
for matches.

• Compare the OR book and page in the 
Reference field of the satisfaction/release of 
mortgage or the lien information to the OR 
book and page in the Primary Reference
field of the mortgage or lien.
• If the OR book and page information does 
not match, compare the names and legal 
descriptions.

3. Do not order or examine 
the matches further.

These liens/encumbrances appear satisfied of 
record and relate to the satisfied liens/
encumbrances.

4. Determine if applicable 
statute of limitations bar 
any instruments from 
enforcement. 

Use the applicable statute of limitations to 
eliminate additional documents. See Title 
Note 22.05.05 (mortgages), 9.04.01 
(contracts), and 21.02.02 (construction liens) 
for more information. Refer any questions to 
an attorney or the legal staff.

5. Do not order or examine 
instruments whose 
enforcement is barred by 
statute of limitations.

6. Order & Examine all other 
documents that affect the 
property.

Note: You may refer to Knox’s Basic 
Judgement Lien Paradigm.

Definition A replat is a parcel of land on which the 
original arrangement, dimensions, or lot 
designations are changed.

Example: A document recites Lot 12, PB 12, 
Page 6. A new survey of record has been filed, 
describing the area covered by this description 
as Lots 26 & 27, PB 24, Page 40. The new 
description is the replat.

Step Comments
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Affect on postings Documents are posted in ATIDS according to 
the legal description. A replatted area affects 
the postings of the subsequent documents.

Example: The document in the example above 
is posted to the replat description, Lots 26 & 
27, PB 24, Page 40, because this now 
describes the property.

Any number of replats may be filed on the 
same area. Every time an area is replatted, any 
subsequent documents referring to the 
affected area are posted to the new 
description.

Partial replat A replat may cover the entire former plat, a 
parcel, or only a few lots. If part of the 
description on the document is not affected by 
the replat, the document is posted to the replat 
and to the description on the document.

Example 1: A document recites Lot 14, PB 6, 
Page 7. The north half of Lot 14 is replatted 
into Lots 1 thru 4, PB 68, Page 2. The 
document is posted to the replat and to Lot 14, 
PB 6, Page 7, because the south half of Lot 14 
is not affected by the replat.

Example 2: A document recites Lots 1 thru 6, 
PB 16, Page 68. Lots 4 thru 6 are replatted 
into Lots 48 thru 50, PB 101, Page 12. The 
document is posted to the replat and to Lots 1 
thru 3, PB 16, Page 68, because postings are 
determined on a lot by lot basis, and not by the 
entire legal description.
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Replat warning message SEARCH ARGUMENTS REPLATTED - 
PLEASE CHECK -

The replat warning message is displayed after 
an ATIDS search if documents are posted to 
legal descriptions other than the description 
you are searching.

The message includes the recording reference 
of up to 4 replats and the names of the 
transactions to use to display all of the replats. 
The message may tell you that additional legal 
descriptions need to be searched for 
documents filed either before or after a 
specific date.

Note: A thorough title search includes 
searches of all legal descriptions that affect a 
parcel during the time span searched. You 
may not find documents posted to a replat 
except by searching the replatted legal 
description.

Additional searches You may need to research the replat to 
determine the correct legal descriptions to 
search. It may be necessary to search multiple 
legal descriptions on different plats.

Additional searches may not be necessary if 
the legal description is not entirely replatted 
and the subject of your search falls within the 
unreplatted portion.

How the Fund branch can help The Mapping Department or the Production 
Department at the Fund branch that serves the 
county in which the property lies can provide 
the new legal descriptions that you need to 
search.
Training Workbook Version: 081711 Page 37



Lesson 1 - The Basics
Name Searches

Performing A Multiple Name Search
The Multiple Name Search transaction is used to perform searches on personal 
names and/or commercial names. Name-related documents do not contain legal 
descriptions. A name search will find recorded documents such as judgments, 
divorces, probates, and federal tax liens. This will generate a printout of document 
information found for the name searched.

What You Do Comments

1. From the Search Menu, 
click the Multiple Name 
Search button.

The Multiple Name Search screen is 
displayed. The type of name search defaults to 
Personal. Note: Review the property 
printout to determine which parties have an 
interest in the title. Search those names, 
including the current holder of the mortgage 
(mortgagee). When a payoff of a mortgage is 
involved in the sale, the mortgagee is searched 
to check for possible name change, merger 
documents, etc. Note: Pop up Blocker for 
www.thefund.com must be disabled for this 
feature to work.
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2. In the Last Name field, 
type       LEBLANC

The seller's name must be searched to 
examine and determine the status of title. 

3. In the First Name field, 
type JEANLUC

Note: To ensure a complete search, all 
variations of the seller’s name should be 
searched in this transaction. For example, 
Leblanc Jean, Leblanc Luc, and Leblanc 
Jean Luc using Flip Names option.

4. Click on the Insert button. A list will be created in the bottom section of 
the screen. 

5. In the Last Name field, 
type LEBLANC 

6. In the First Name field, 
type JEAN

7. In the Middle Name field, 
type LUC 

 

8. Click on the Insert button. 

What You Do Comments
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9. Click the Edit hyper-link 
for Jean Luc Leblanc.

This will display the Multiple Name 
Search Edit window with additional search 
options, such as percent of likeness, 
nicknames, similar sounding names and flip 
names.

10. Click Y for flip names. The Flip Name option will flip only middle 
and first name and perform those additional 
searches. 

11. Click the Save Edit
button. 

The Multiple Name Edit window will close 
and the Multiple Name Search window 
will re-display indicating that the search 
options have been changed. 

12. In the Last Name field, 
type LEBLANC

13. In the First Name field, 
type FRANCINE

Note: If a woman's name has a middle initial, 
it is recommended to omit the middle initial in 
the search.

14. Click the Insert button The name will be added to the list created in 
the bottom section of the screen.

What You Do Comments
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15. Click the Commercial 
option button.

16. In the Commercial 
Name field, type 
REALISTAT REALTY.

When searching Commercial Names use 
spaces between words. Do not use commas.

17. Click the Insert button. The name will be added to the list created in 
the bottom section of the screen.

18. Click REALISTAT 
REALTY hyper-link. 

This will access the Commercial Name 
Variations search window, and display a list 
of the Commercial Name Variations. 

What You Do Comments
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Note: 1) The Commercial Name Variations transaction is used to find 
possible name variations for trusts and commercial names. Any additional 
commercial name variations that may be found using this transaction should be 
searched. The Commercial Name Variations transaction will find name 
variations of documents posted in the ATIDS system. 2) The name highlighted 
in yellow suggests the closest match to the searched name. Review the list to 
determine which name variation should be searched. 3) Commercial Name 
Variations are county specific! It is necessary to execute the search transaction 
in the county where the property is located in order to obtain accurate results. 4) 
The system will default to the Authorized Abbreviation of the name. 

19. Select variations of names 
to search by clicking the 
check box to the left of the 
name.

Make sure to select all variations that apply. 

20. Right click your mouse and 
select print. 

Note: You must keep a copy of this search for 
your records.

21. At the bottom of the 
Commercial Name 
Variation screen select the 
Add Names button.

This will add the selected names to the search 
list. the Multiple Search window is re-
displayed. 

What You Do Comments
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What You Do Comments

22. Click the Search button to 
execute all name searches. 

Your results will be sent to the printer. If 
Document Order was selected, this action 
will also send search results to the 
Document Order queue.

23. Review the Certified Name 
Search Printouts. 
Determine which 
documents must be ordered 
and examined.
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                  Sample of Certified Name Search Printout for Jeanluc Leblanc
Page 44 Web ATIDS Ver. 3.2



Lesson 1 - The Basics
               Sample of Commercial Name Certified Printout for Realistat Realty
Training Workbook Version: 081711 Page 45



Lesson 1 - The Basics
What You Do Comments

24. “X Marks The Spot” An 
extract from the printout 
above is duplicated below 
for further comment.

This is an example of the “X Marks The 
Spot” search enhancement.

Note: The Fund has adopted a search enhancement called “X Marks The 
Spot.” The Fund marks certain documents in Web ATIDS with an X to indicate 
that a document is satisfied of record or is no longer enforceable by statute. 
You do not need to order or examine documents marked with an X as part of the 
title examination.

Search Tips for Personal Names
•Personal names can only contain alphabetical letters and hyphens.
•Valid alphabetical letters are A-Z
•Search hyphenated names with the hyphen.Example: Search Sally Jesse-Raphael as:
 

Last Name: JESSE-RAPHAEL
First Name: SALLY

•Omit a woman's middle name or initial. Example: Search Sherry S. Hansen as:
 

Last Name: HANSEN
First Name: SHERRY
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•If a married woman has a different last name than her husband, search her name in 
two ways. First, search the name with the given first and last name. Then search the 
name using the given first name and the husband's last name. Example: Mary T. Fox, 
married to John D. Smith, should be searched as:

Last Name: FOX
First Name: MARY

Last Name: SMITH
First Name: MARY

•When a last name includes a Suffix, do not include it in the search.Examples: Jr, Sr, 
II, III should not be included in the data entry into the name search fields 
•When a name contains an initial as a first name along with a full middle name, also 
search the middle name as the first name.Example: Search G. Robert Arnold as:

Last Name: ARNOLD
First Name: ROBERT
Middle Name: G

Last Name: ARNOLD
First Name: G
Middle Name: ROBERT

•Some foreign names may have the surname in the middle name position. To ensure a 
complete search, also search the middle name as the last name. Example: Search 
Mobasher Mohammed Ali as:

Last Name: ALI
First Name: MOBASHER

Last Name: ALI
First Name: MOHAMMED

Last Name: MOHAMMED
First Name: MOBASHER

Last Name: MOHAMMED
First Name: ALI
Middle Name: MOBASHER

•The Flip Names feature is helpful in searching foreign names, and also in searching 
names that begin with initials 
•The Search From Date defaults to 21 years prior to the certification date
•Documents with X's after the Primary Reference fields (OR BK and PG) do not 
need to be ordered or reviewed
•Search an Also Known As (A/K/A) name, as well as the true name
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Search Tips For Commercial Names
•Remember to select the radial button to change the Name Search type from 
Personal to Commercial.
•Commercial names may include numerals, ampersands (&), hyphens and periods 
used in domain names (.com, .org).
•Do not include commas or other punctuation marks in the name.
•Use a space between words
•Search names that contain letters as words with and without spaces between the 
letters. Example: TCBY YOGURT:

Name: TCBY YOGURT Name: T C B Y   YOGURT

•Names containing a hyphen should be searched with the hyphen Example: A-1 
REALTY, INC.

Name: A-1 REALTY INC

•Search trusts and professional names as both commercial and personal names. 
Example 1: David S. Jones Trust: 
Search the Commercial Name

Name: DAVID S. JONES TRUST

And Search the Personal Name
Last Name: JONES
First Name: DAVID
Middle Name: S

Example 2: Sanjay Gupta, M.D. Search the Commercial Name
Name: SANJAY GUPTA MD

And Search the Personal Name
Last Name: GUPTA
First Name: SANJAY

•The Search From Date defaults to 21 years prior to the certification date
•Documents with X's after the Primary Reference fields (OR BK and PG) do not 
need to be ordered or reviewed
•Use the Commercial Name Variations transaction to find variations of trust and 
commercial names. Then, go back to the Name Search transaction to search the 
name variations found
•You MUST keep a copy of the Commercial Name Variations Search for your 
records
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WHO Do You Perform Name Searches On?
• The names of the parties currently in title.
• The proposed purchaser/mortgagor.
• Parties having an interest in the real property.

WHY Do You Perform Searches On Names?
• To identify any existing liens that may attach to the real property being 

conveyed.
• To identify any existing liens that may attach to the real property of the 

proposed purchaser/mortgagor.
• To identify any existing liens that may attach to the real property of any parties 

having interest in it.

For example: You should perform name searches on the mortgagee(s) for federal tax 
liens, notice of RICO liens, bankruptcy proceedings, and other miscellaneous 
instruments that may change the personal or corporate status of the mortgagee(s).

Guidelines for Eliminating Instruments

Name Search Guideline
Instrument Type Comments

Judgments, tax liens and 
similar instruments creating 
general liens against persons, 
trust, and entities.

For issuing an ORNTIC/ATFS policy, it is not 
necessary to order or review copies of 
judgments, tax liens, and other instruments 
creating general liens that are satisfied of 
record or unenforceable by statute.

How to Apply This Name Search Guideline
Step Comments

1. Review the Name search 
printout starting with the 
effective date of the search.

Note all references to judgments, 
satisfactions/releases of judgments, liens, 
satisfactions of liens, etc.
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2. Eliminate all judgments 
and similar documents 
with an X beside the OR 
Book and Page number of 
the Primary Reference
field.

Apply the X Marks The Spot Fund search 
enhancement. 

3. Compare printout entries 
for matches.

Compare the OR Book and Page numbers, 
clerk's number, case number, or chancery 
order number in the Comments field of the 
satisfaction of judgment or the lien to the 
Primary Reference or Secondary 
Reference fields of the underlying judgment 
or lien.

4. Eliminate all documents 
that appear satisfied of 
record and all related 
documents. For example, 
another judgment with the 
same case number in the 
Comments field or an 
assignment of judgment. 

Do not order or examine the matches further. 
These liens/judgments appear satisfied of 
record and relate to the satisfied liens/
judgments.

5. Determine if applicable 
statute of limitations bar 
any instruments from 
enforcement. 

Use the applicable statute of limitations to 
eliminate additional documents. See Title 
Note 18.03.03 for more information. Refer 
any questions to an attorney or the legal staff.

6. Do not order or examine 
instruments whose 
enforcement is barred by 
statute of limitations.

Note: You may refer to Knox’s Basic 
Judgement Lien Paradigm.

7. Order & Examine all other 
judgments and liens and 
other name search 
documents that potentially 
affect the property or apply 
to the transaction.

Step Comments
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Order Documents Menu
Use the Order Documents transaction to order hard copies of documents that were 
found as a result of the property and name searches. The Order Documents
transaction also has the flexibility of allowing an order of documents related to the 
closing transaction file which were not found in the original search. The Order 
Documents transaction has a variety of methods of delivery, such as: branch 
delivery, fax, mail, ProPel, etc. 

What You Do Comments
1. Begin at the Main Menu.

2. Click the Order 
Documents Menu
button.

The Order Documents Menu screen is 
displayed. 
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3. Confirm that the County
and File Name/No. fields 
are correct. If not, enter the 
appropriate information.

County = Palm Beach
File Name/No. = LEBLANC20CY

4. Click the Delivery 
Information button.

The Delivery Information screen is 
displayed.

What You Do Comments
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5. Place the cursor in the first 
Phone field and type 407
then press TAB and type 
555 then press TAB and 
type 5000.

The Phone field is a required field and must 
be completed. Note: Use the TAB key to 
navigate through the Phone field.

6. Place the cursor in the first 
Fax field and type 407
then press TAB and type 
555 then press TAB and 
type 5001.

Note: The Fax field is a required field if the 
Delivery By field is set to Fax.

7. Tab to the Ordered By
field and type [Your 
Name]

8. Tab to the Responsible 
Party field and type 
Richard Bruce.

9. Tab to the Deliver By
field and select the delivery 
method desired.

Note: When ProPel® is enabled, it will default 
to the ProPel delivery method. 

Note: Clicking on the Preference hyper-link 
and entering your user preferences will store 
this information and by default populate into 
future requests. (see Establishing Preferences 
handout)

What You Do Comments
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10.  Click the Select 
Property   Documents
button.

The Document Selection - Property
screen is displayed. Note: The screen has 2 
pages. Click the appropriate buttons to 
navigate through the pages, as necessary. 

What You Do Comments
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11. Select the documents that 
need to be ordered by 
clicking on the box 
under the Select column. 
For the purposes of this 
example, select:

•       OR 23134/547
•       OR 22801/1480
•       OR 20863/85
•       OR 19736/1301
•       OR 17664/583
•       OR 12927/480
•       OR 12658/881
•       OR 11841/765

Tab to Page 2 of the Document Selection-
Property Screen as necessary to select 
documents. Note: The documents are shown 
in the same order as the property printout. 
Refer to the property printout when selecting 
the necessary documents.

Note: To order specific pages within a property document, click on the book 
icon next to the document under the Select column. Then make one selection 
accordingly. The Select Specific Pages screen from which the choices are 
made is shown below.

What You Do Comments
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Note: The END OF DOCUMENT INFORMATION - PROPERTY message 
is displayed when there are no more screens of property documents to display.

12.  Click the Select Name 
Documents button. 

The Document Selection - Names screen 
is displayed. Names are displayed in 
alphabetical order. Note: To go directly to the 
next name, click on the Next Name button at 
the top of the screen.

What You Do Comments
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13. Click on the Next Name
button until the 
commercial name 
REALISTAT REALTY 
screen is displayed.

14. Select the following 
document: OR 7338/854. 

Note: (1) The ATIDS system does not allow X Marks The Spot documents to 
be selected on this screen. (2) The D/U field will indicate a D for a document 
duplicated on the list of search results and a U for a document that was a result 
of an update search. The END OF DOCUMENT INFORMATION - NAMES
message is displayed when there are no more name documents to display.

What You Do Comments
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15. Click the Add'l Search 
Related Documents
button.

The Order Documents/Add'l Search 
Related Documents screen is displayed. 

Note: (1) Use the Add'l Search Related Documents screen to order copies 
of documents related to the ATIDS file that were not found in the property or 
name search such as a copy of the plat, Schedule B exceptions on the prior 
policy, etc. Documents related to the ATIDS search are free, except for 
Condominium documents. (2) Copies of documents not related to an ATIDS file 
can be ordered by using an arbitrary file number and typing the recording 
reference in the Non-Search Related Documents (Billable) screen in the 
Order Documents Menu. There is a $1.00 charge per page to obtain these 
documents if the delivery method is not ProPel. For ProPel, the charge is $0.60 
per document. Condominium documents are at an additional charge. If the Non-
Search Related Documents (Billable) option is chosen, a message will 
appear on your confirmation sheet printout: BRANCH INVOICE WILL BE 
PREPARED FOR DOCUMENTS ($1.00 PER PAGE) RELEASED TO 
THE BRANCH.

What You Do Comments
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16. Click in the Primary Ref
field and type PB in the 
Source box, press TAB
and type 29 in the Book
box, press TAB and type 
196 in the Page box. 

Note: (1) When ordering a document which 
did not appear on the property search printout 
or name search printout, type the primary 
reference of the document in the Primary 
Ref field. If a primary reference is not 
available on the document, type the clerk's 
number in the Secondary Ref field 
(Example: CN 1985 12345). (2) The Add'l 
Search Related Documents screen allows 
28 instrument entries. To increase the number 
of instruments to be ordered in this 
transaction, call the Fund’s Help Desk.

What You Do Comments
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17. Click the Send Order
button. 

The Document Order is released to the 
Branch and a confirmation sheet is printed. 
After the order is released, the Order 
Documents Menu screen is displayed.

Note: If the HARD COPY REQUEST number is not displayed on this screen, 
the order has not been released.

What You Do Comments
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                               Sample of Hard Copy Request Confirmation
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Receiving ATIDS Search Results & Documents Electronically 
Via ProPel®

ProPel®, the Fund's electronic document storage and imaging software package, is the 
perfect complement to ATIDS. With ProPel, the Fund can transmit high-quality, first-
generation images directly to your PC, as opposed to lower-quality fax images, or 
delivery via courier. It provides faster access and easier transfer, plus quicker turn-
around time for your clients - many documents can be transmitted to you in minutes, 
and you can receive Branch Products faster, eliminating courier delay.

Designed to keep you competitive in today's quickly changing marketplace, ProPel 
provides e-mail and export options and gives you the capability to receive, organize, 
and electronically store documents, as well as ATIDS search results.

ProPel eliminates the need for costly fax and courier services as well as off-site storage 
of real estate files. The Scan feature allows you to add important documents into 
ProPel for electronic storage on a variety of write-able media (such as disks, CDs, and 
network file systems, to name a few) eliminating off-site storage costs. Once you begin 
storing and managing your documents, products, and search results in ProPel, the need 
to maintain actual hard copy storage files can be greatly reduced or eventually 
eliminated.

Features of ProPel® give you the capability to:
• Receive, organize, electronically store, e-mail, and export documents, 

including ATIDS search results.
• Print individual or multiple pages.
• View documents or pages with thumbnails.
• Scan important documents into ProPel for electronic storage, eliminating off-

site storage costs.
• Arrange/rearrange and name/rename documents and folders.
• Increase or decrease magnification of the display and rotate a document.
• Copy and paste selected areas of documents into other documents.
• Move documents between disconnected ProPel-enabled PCs by exporting 

documents to a Package File and importing that Package File onto any other 
ProPel PC.

• Add any type of documents to ProPel, extending its usefulness as a document 
storage solution.

• Add notes to documents.
• Change the document sequence within any folder to follow the Chain of Title.
• Receive Branch Products, their supporting documents, and corresponding 

DoubleTime® data files via ProPel.
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What You Do Comments

1.  Double-click the 
ProPel icon on your PC 
Desktop to start ProPel.

The ProPel screen is displayed.

2.
 

 Click Get 
Documents on the ProPel 
tree view toolbar

The ProPel Delivery Processor
automatically connects to The Fund and 
checks for any orders (hard copy or Branch 
Products) that were waiting for pickup, and 
delivers them.

Once the order has been successfully 
downloaded, the message Delivery 
Completed Successfully is displayed. A 
(+) is then displayed in front of the Inbox 
indicating that a new order has been delivered. 
Note: * Refresh F5: to update the Tree view 
Pane.
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3. Click the (+) in front of the 
Inbox.

New orders arrive into the Inbox and are 
displayed as a folder name. The folder name is 
the same as your file created in ATIDS. In the 
following screen shot, we can see the new 
folder named ATIDS filename.

4. Click the (+) in front of the 
folder ATIDS filename.

The folder expands and displays the contents 
of the folder. Note: The method by which 
folders arrive into the Inbox and any 
additional text that is displayed next to ATIDS 
search printout documents depends on how 
ProPel is configured, using Tools > Options 
> Inbox.

5. Click the (+) in front of the 
folder FundNet User ID.

What You Do Comments
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This second level sub-folder contains the 
search results of each search that you 
performed in the ATIDS Search menu 
(property search and name searches). The 
other first level sub-folder ATIDS filename 
[FL-006-2011-017558] (not yet expanded) 
contains the related hard copy documents that 
were requested while in the ATIDS Order 
Documents (HCPY) Menu.

6. Click the (+) in front of the 
first level sub-folder 
ATIDS filename [FL-
006-2011-017558]

The folder expands and displays the contents 
of the folder (in this case, image files in the 
Acrobat Portable Document Format or PDF). 
Note: The configuration options you set in 
Tools > Options > Inbox determine 
whether an arriving hard copy (HCPY) folder 
is created as a sub-folder of a related folder or 
as a separate folder at the same level. Folder 
names for HCPY documents always show the 
Request ID information after the folder name. 
ATIDS filename [FL-006-2011-017558]

What You Do Comments
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7. Double-click the Sub 
Condo document to open 
it into the Document Pane 
Viewer.

This document is the property search printout 
that you performed in ATIDS.

What You Do Comments
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8.  Click Decrease 
Magnification in the 
Acrobat Document Viewer 
Pane toolbar.

The default magnification for the Document 
Viewer is based on the percentage that allows 
one page to fit in the Document Viewer Pane. 
(It varies by the document and by the 
configuration of your ProPel window.) 
Decreasing the magnification makes the 
document smaller in the Viewer. Note: When 
a document is open in the Acrobat Document 
Viewer, the Acrobat toolbar is activated. 
There is no need to click to select the 
document.

9.  Click Increase 
Magnification in the 
Acrobat Document Viewer 
Pane toolbar.

This makes the document larger in the Viewer. 
Note: Use the scroll bar on the right to view 
all pages of the property search

10. Double-click each of the 
search results documents to 
open them in the Viewer.

Note: As you open multiple documents, each 
subsequent document is opened on top of the 
previous one. A maximum of 20 documents 
can be open at one time. 

What You Do Comments
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11.
 

Close the current 
opened document by 
clicking Close 
Document      on the 
ProPel tree view toolbar.

The document closes from the Viewer, but any 
previously opened documents remain open. 
Note: Close all open documents from the 
Viewer simultaneously by clicking File > 
Close All in the ProPel tree view menu.

12. Double-click the document 
TOC [FL-006-2011-
017558]

This is the print confirmation page for the 
hard copy (HCPY) order released in ATIDS. 
The Request ID number for the HCPY order 
is added automatically by ProPel after TOC in 
the file name. Note: All hard copy documents 
ordered are listed on the TOC (Table of 
Contents) document.
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13. Double-click each of the 
hard copy documents to 
open them into the Viewer, 
opening the Plat PB 29 
196 last into the Viewer, so 
it is on top.

We'll use this document to demonstrate the 
Rotate tool.

What You Do Comments
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Archiving Documents and Folders
To conserve hard drive space on your computer, you can archive documents and 
folders onto almost any kind of recording media (for example, a network server drive, 
a writeable CD, a Zip drive, or a removable disk drive, to name a few). 

To use the Archive feature of ProPel, first create an Archive Folder which ProPel 
stores on the external drive, but displays in the ProPel tree view. Then, select the 
documents or folders you want to archive, and drag them into the Archive Folder. 
ProPel keeps track of the Archive Folder location.

14. Click Tools > Rotate
Clockwise in the ProPel 
tree view menu to rotate 
the page to its upright 
position.

Note: To rotate a complete document you 
must right click on the document, and click 
Tools > Rotate Clockwise. 

15. Close all open documents 
from the Viewer 
(Remember, File > Close 
All).

Note: You will be asked if you want to save 
the changes you made to PB 29 196 before 
closing. Click Yes. The change you made was 
to rotate the document clockwise. Once you 
save this change, each time you open this Plat, 
it will be correctly oriented

What You Do Comments
1. Select the Archive Root

folder (a cabinet symbol) at 
the bottom of the tree view.

What You Do Comments
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2. Click New Folder   on 
the ProPel tree view 
toolbar (or select File > 
New > Folder in the 
menu).

The Browse for Folder dialog box is 
displayed. Note: For training purposes, we 
will create the folder on your PC Desktop; 
however, it is very important that you consult 
your Information Technology (IT) 
Administrator for the file target location of 
your archived documents and folders. Do not 
archive ProPel documents and folders on your 
office PC Desktop.

3. Select a location for the 
new folder (for example, a 
network server drive, a 
writeable CD, a Zip drive, 
or a removable disk drive), 
then click OK.

A folder named New Folder is created in the 
tree view (to represent the folder on the 
external media) where the documents will be 
stored. The folder name is selected 
(highlighted) to show you are in Edit mode. 
The folder name you type replaces the text, so 
make sure not to touch any other keys before 
you type the folder name.
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4. Type Atids Searches as 
the name for the new folder 
then press the ENTER key.

This name is used only in the tree view to 
identify the folder for you. ProPel uses its own 
folder naming convention to keep track of the 
folder on the external drive. Note: It is highly 
recommended that you move folders and 
documents out of the Inbox as soon as 
possible in order to maintain a functional and 
organized working environment. It is also 
important to regularly archive folders out of 
the ProPel tree view.
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5. Click, hold, and drag the 
ATIDS filename [FL-
006-2011-017558] folder 
from the Inbox toward the 
Archive folder you just 
created until this 
destination folder is 
highlighted, then release 
your mouse button. See 
Lesson 7 of this Workbook 
(pages 231 through 276) 
for other suggested 
working environment 
examples for your office.

By holding, dragging, and releasing a folder, 
you have moved the entire folder (with its 
contents and sub-folders) into the Archive 
folder, out of your Inbox and off the Root of 
ProPel. Notice that as you begin to drag 
(move) the folder, ProPel shows a simulation 
of the folder to guide you. Make sure you do 
not release your mouse button until the 
destination folder is highlighted. Note:(1) 
Once moved out of the Inbox, orders (folders 
and documents) cannot be moved back into 
the Inbox. (2) The archived folder can be 
renamed to add additional identification 
information.
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Updating The Property Search (Single Legal Description)
Use the Update Property Search transaction to continue the property search from a 
previous search. An Update Property Search is performed prior to the closing and 
again prior to issuing the title insurance policy. The Update Property Search
transaction will only show property documents that have been recorded and posted 
since the last property search was run on the file.

What You Do Comments
1. Launch Web ATIDS. 

Navigate from the Main 
Menu to the Search 
Menu. 

2. On the Search Menu, place 
the cursor in the File 
Name/No. field. Type 
[Your File Number]

This is the file we previously created and 
used. Note: Use the ATIDS file number which 
was used previously for the property search 
you wish to update.

3. Confirm that the County 
field is set to the correct 
county for the transaction. 
If not, change it to the 
correct county. 

Remember that the property is located in Palm 
Beach County. 
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4. Click the Update 
Property Search button.

The Update Property Search screen is 
displayed.

5. Select Update from the 
drop-down selection 
window.

Selecting Update next to the legal allows an 
update search to be run on the previously 
searched property.

6. Click the Submit button. The Subdivision/Condo Search screen is 
displayed. The Search From Date field 
defaults to the date of the last property search 
automatically.

7. Click the Submit button. The Property Update Search is 
performed.

What You Do Comments
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8. Click the Deliver Search 
Results button.

The Update Property Search results are 
printed and the Search Menu is displayed.

What You Do Comments
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                                              Sample Update Property Search Printout

9.  Review the printout to 
determine whether any new 
exceptions or requirements 
are found.

What You Do Comments
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Updating The Property Search (Multiple Legal Descriptions)
What You Do Comments

Select Multi next to any legal 
from the drop-down selection 
area of the Update Property 
Search window.

This selection will indicate a multiple search.

Click the Submit button. The screen is redisplayed and the Multiple 
Search Request is initiated.

Select Update next to each 
legal that requires to be 
updated from the drop-down 
selection area.

The legals must be selected to complete the 
multiple update.

Click the Next button. The Subdivision/Condo Search screen is 
displayed with the selected legals.

Click the Submit button. The multiple update search is performed.
Click the Deliver Search 
Results button.

The update results are printed and the Search 
Menu is displayed.

Updating The Name Search
The Update Name Search transaction is also used to update or continue a name 
search from a previous name search. An Update Name Search is performed prior to 
the closing and again prior to issuing the title policy. The Update Name Search will 
show documents indexed against names that have been recorded and posted since the 
last name search.

What You Do Comments
1. On the Search Menu, place 

the cursor in the File 
Name/No. field. Type 
[Your Current File 
Number/Name]

This is the file we previously created and 
used. Note: Use the ATIDS file number which 
was used previously for the property search 
you wish to update.

2. Confirm that the County 
field is set to the correct 
county for the transaction. 
If not, change it to the 
correct county. 

Remember that the property is located in Palm 
Beach County. 
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3. Click the Update Name 
Search button.

The Update Name Search screen is 
displayed. Note: All names previously 
searched on the file are shown, and by default 
are selected for the update search. If 
necessary, deselect any not to be searched.

4. Click the Search button. The Update Multiple Name Search screen 
is re-displayed. The check marks indicate that 
the search was completed and the results are 
sent to the printer.
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5. Review the printout to 
determine whether any new 
exceptions or requirements 
are needed.

Note: When updating commercial name searches, it is important to always run a 
Commercial Name Variations transaction from the Update Multiple 
name Search window in order to make sure there have been no new 
commercial name variations entered since the date of your last search. If there 
are any new variations found, those variations should be searched, too. Note:
When updating a personal name search where the Flip Name feature was used, 
you must continue to use the Flip Name feature in your update search in order 
to ensure a search will also be performed on that changed name. 
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   Sample Update Name Search Printout for Jeanluc Lelanc
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 Sample Update Name Search Printout for Realistat Realty
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Policy Rating
The Policy Rating transaction is used to calculate the promulgated and premium 
amounts for ORNTIC/ATFS policies and endorsements. Calculations are displayed 
and can be printed. The printout can be submitted to The Fund instead of the Policy/
Endorsement Calculation Worksheet, along with a copy of the policy and a 
check for the premium remittance. A TITLE Yes file must be opened before Policy
Rating can be accessed.

What You Do Comments
1. Launch Web ATIDS. 

Navigate from the Main 
Menu to the Search 
Menu. 

2. On the Search Menu, place 
the cursor in the File 
Name/No. field. Type 
[Your File Number]

This is the file we previously created and 
used. Note: Use the ATIDS file number which 
was used previously for the property search 
you wish to update.

3. Confirm that the County 
field is set to the correct 
county for the transaction. 
If not, change it to the 
correct county. 

Remember that the property is located in Palm 
Beach County. 

4. Select the appropriate 
Delivery Option. 

We will print the results.

5. Click the Policy Rating
button.

The Policy Rate Calculation - 
Endorsements screen is displayed. 
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6. In the Policy Type field, 
type OF6 and press TAB. 

7. In the Policy No. field 
type 8200080 and press 
TAB.

8. In the Amount of 
Insurance field type 
150000 and press TAB.

$150,000 is the amount insured on the 
Owner's Policy. Note: Do not type commas.

What You Do Comments
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9. In the Rating Date field 
type today’s date. 

The Rating Date is the effective date of the 
commitment or policy. Note: Commitment 
Number/Amount field: If a commitment 
was issued, type in the serial number (if any) 
and amount. If you key in a commitment 
serial number, the amount is required. 
Timeshare Transaction field: This field 
defaults to No. If this transaction is for a 
timeshare, change selection to Yes.

 

10. Place the cursor in the 
Simultaneous Policy 
Type field, and type MF6
and press TAB.

Note: Leave this field blank if there is not a 
simultaneous issue.

11. In the Number field type 
8300050 and press TAB.

12.  In the Amount field type 
100000.

$100,000 is the amount insured on the 
Mortgagee Policy. Note: Do not type commas. 
Note: If Re-issue Rate is being given, 
complete Prior Owner's Policy section. If 
this transaction qualifies for a New Home 
Discount, then select Yes. Also enter the 
additional required information.
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13.  Click the Next button. The Endorsements screen is displayed.

What You Do Comments
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14.  Click in the ALTA 9.0-06
field and select yes.

Note: Select No if there is no mortgagee 
policy being issued.

15. Click in the Survey 06
field and type 1.

Typing a 1 indicates one Survey
endorsement was issued.

16. Click in the Residential, 
Commercial field and 
select Residential 1-4 
from the drop-down 
selection.

Other property type selections are available. 
Use the drop-down selection window for 
options.

17. Click in the Florida 8.1 
Environmental field and 
type 1.

18. Click the Submit button The Totals screen is displayed.

19.  Click the Print button. A printout is generated with the total premium 
and promulgated rates. Note: The Policy 
Rating transaction will only be available 
when a TITLE Yes file is opened. This 
requires the firm to follow up by issuing an 
ORNTIC/ATFS Title policy. 
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20. Review the Policy/
Endorsement 
Calculation Worksheet.

The worksheet is to be forwarded to Fund 
Headquarters along with a copy of the policy 
and a check for the premium payable to Old 
Republic National Title Insurance Company.
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                     Sample Policy Calculation Worksheet
Training Workbook Version: 081711 Page 89



Page 90 Web ATIDS Ver. 3.2



O
b

ta
in

in
g

 B
a
s
e

T
itle

 In
fo

rm
a
tio

n



Lesson 2 - Obtaining Base Title Information
Lesson 2 - Obtaining Base Title Information

Concept
In this Chapter you will learn to use contract or property information to search for all 
prior title policies issued by The Fund or NATIC or processed by ATFS for 
subdivisions and condominiums. If a prior policy exists, you will also learn how to 
order a hard copy of the prior policy and a Chain ATIDS Pre-Computer product, which 
is used when the base is dated prior to the on-line computer records. You will also 
learn to view the certification information for property records in on-line counties. 

Objectives
• Change the search county.
• View on-line certification dates for property records.
• Search for a prior policy issued on The Fund or processed through The Fund.
• Order a copy of a prior Fund or ORNTIC/ATFS policy.
• Order a Chain ATIDS Pre-Computer (Product #14) from a Fund branch.

Transaction Information
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View/Change County
What You Do Comments

1. On the Main Menu, click 
the Change County
button.

The View/Change County screen is 
displayed
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2. Select Manatee county 
from the drop-down choice 
box in the Current 
Search County area.

3. Click the Update County 
button.

The Current Search County changes to 
Manatee county

4. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.

What You Do Comments
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County Certification Information
The County Certification Information transaction is used to view certification 
information for property records in on-line counties. The system displays the date the 
county came on-line and the date and time of the on-line county's certification. The 
most current posting and certification to the Property Index are also displayed. This 
is shown with Official Records (OR) book and page number, except in some counties 
where it is shown with the Official Records Instrument number (i.e. Sarasota, Baker, 
Lee, Desoto and Gilchrist counties).

What You Do Comments
1. From the Main Menu, click 

the County Certification 
Information button.

The County Certification Information
screen is displayed.

2. Click the Next button. The second screen is displayed. Note: 
Manatee county on-line 06/27/1988. Be sure 
to compare this date with the effective date of 
the prior policy before proceeding with the 
property search.
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3. Click the Next button. The third screen is displayed

4. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.
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Finding A Prior Policy - Subdivisions/Condominiums
Use the Policy Search and Order transaction to search for prior Fund or NATIC 
title policies as well as ORNTIC policies issued through ATFS for subdivisions, 
condominiums, and acreage legal descriptions. Corresponding plat information is 
displayed, along with the number of policies found, if any. Prior policies are available 
only when ordered directly through ATIDS and when opening a TITLE Yes file.

Try This
You have the transaction information for the Bishoff file at the beginning of the lesson. 
Use it, together with the information you have just obtained about the prior title 
insurance policies, to conduct the property search on the University Pines property. 

What You Do Comments
1. Search Menu > Add/

Change/Find Files
Open a new file using the Title Yes bill code.

What You Do Comments

2. Confirm that the County
field shows Manatee.

If it does not, select Manatee county from 
the drop down box.
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3. Click the Policy Search 
and Order button

The Policy Search screen displays. 

4. In the Source of Plat
field, select PB-Plat Book.

What You Do Comments
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5. Click in the Book 
Number field and type 22
and press TAB.

6. In the Page Number field 
type 65 and press TAB. 

7. In the L1 Lots/Units field 
type 21.

Note: The Search From Date indicates 
01011900, an erroneous date in order to 
search as far back as possible for that county. 
The Through Date defaults to the most 
current available date for that county.
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8. Click the Next button. A summary of the prior policies found for the 
search is displayed. Note: To select and order 
policies, Bill Code must be Title or 
Interval Yes.
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Note: 
• The prior policy information is displayed in the following order: Flagged, 
Policy Type, Policy #, Policy Effective Date, Issuing Agent #, Policy 
Amt., Recording Ref., and Seq. of the document being insured. Legal 
descriptions are indented directly below the policy information.
• To select and order policies, Bill Code must be Title or Interval Yes.
• To search an entire block or building, leave L1 blank and key in a block or 
building in L2.
• Please refer to the Appendices in the ATIDS manual for policy type codes.
• Flagged Policies: If a policy cannot be used as a base (for example, a claim 
has been filed or is incomplete), an asterisk (*) is displayed if there is a claim 
against the policy. a (U) is displayed in the Flagged column next to the Policy 
Type for incomplete policies. You will need to select another policy or order a 
TAC, if available.
• IT IS MANDATORY TO OPEN THE FILE AND PERFORM A 
PROPERTY SEARCH BEFORE A PRIOR POLICY CAN BE 
ORDERED.

9.  Click the Next button. The prior policy search results are displayed 
with detailed policy information.
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Try this - Continued

• Note: Title Status Report. A Title Status Report is a report on the 
property regarding the status of title up to the recording of the subject plat or the 
recording of the declaration of condominium. You cannot order a Title Status 
Report because they are used by Fund Branch personnel. However, when a 
Title Status Report exists, you can order a Title Assumption Certificate
(TAC) for a Title Policy Intent "Yes" file. The TAC shows the status of the 
title to a platted lot or condominium unit. When using a TAC as the base title, 
start the search from the date of plat (subdivisions) or the date of the declaration 
of condominium (condominiums). To order the TAC, use the Order Branch 
Products transaction.

10. Print current screen. You may print screen by right clicking and 
selecting Print. 

11. Click the Search Menu
button under the Options
section.

The Search Menu is displayed.

What You Do Comments

12. Search Menu >
Subdivision/Condo 
Search

Search the University Pines property.

What You Do Comments
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No Exact Policy Match - Subdivision/Condominium Property
If no exact match prior policy can be found on property to be examined in a 
subdivision or condominium, a Fund member has the option of examining the property 
to be insured from the date of plat or recording of the Declaration of Condominium, 
and ordering prior policies on other property in the same subdivision or condominium. 
A minimum of two prior Fund policies within the same subdivision or condominium 
issued by different agents must be ordered. The prior policies for subdivisions should 
be on lots in close proximity to the property to be insured. The member must compare 
exceptions on Schedule B of the prior policies and include all exceptions in the new 
policy which affect the property being insured.

Using Similar Prior Subdivision/Condominium Policies

13. Review and verify search 
criteria

Search from dates are dictated by the certified 
from date for the county being searched.

What You Do Comments
1. Search for an exact match 

prior policy on the 
property. If no prior Fund 
policy is found, go to step 2
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No Prior Policy - Subdivisions Only
When no prior title policy is available to use as a title base, The Fund permits the 
examination to begin with the deed into the developer of subdivision property, 
provided (1) that the plat has been of record for seven or more years and (2) the streets 
and common areas on the plat are dedicated to the public.

2. Determine if a Title 
Status Report exists for 
the subdivision/
condominium. If no Title 
Status Report exists, go to 
step 3.

Although a Title Status Report is not 
available to Fund Members, Branch personnel 
will use the Title Status Report to prepare a 
Title Assumption Certificate for use by 
the member. It may be necessary to phone the 
Fund Branch to inquire about and order the 
Title Assumption Certificate. 

3. Search for inexact match 
prior policies on nearby 
lots in the same 
subdivision or any other 
units within the 
condominium.

4. Perform a property search 
on the property to be 
insured, using the date of 
plat of the subdivision or 
the recording date of the 
Declaration of 
Condominium as the 
Search From date.

5. Order two prior policies, 
each issued by different 
Fund members. For 
condominium property, 
order two policies on any 
units, each issued by 
different Fund member.

This assumes the inexact prior policy matches 
were found.

6. Compare the Schedule B 
exceptions on each of the 
selected lots or units. 
Include all exceptions that 
affect the property being 
insured in the new policy.

This assumes the inexact prior policy matches 
were found.
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Using Plat As Title Base
What You Do Comments

1. Use the Plat Information 
From Plat Name
transaction to verify that 
the source of plat date for 
the subdivision is at least 
seven years old.

If the plat has not been of record for at least 7 
years, the plat may not be used as a base title 
for examination purposes.

2. Order a copy of the plat. 
Verify that the streets and 
common areas on the plat 
are dedicated to the public.

If the streets and common areas shown on the 
plat are not dedicated to the public, the plat 
may not be used as a base title for 
examination purposes.

3. Determine the underlying 
legal description of the 
platted property.

This and the following steps assume that the 
plat has been of record for seven or more 
years and that the streets and common areas 
shown thereon were dedicated to the public.

4. Identify the date of the 
deed into the platting 
developer by performing a 
DEEDS search on the 
underlying property and 
review the property search 
printout.

5. Perform full property 
searches on both the 
subject property and the 
related underlying 
property. Start the search 
on the underlying property 
with the recording date of 
the deed into the developer. 
Start the search on the 
subject property with the 
recording date of the plat 
and order hard copies of 
the documents that are not 
eliminated.
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No Prior Policy - Condominiums Only
When no prior title policy is available to use as a title base, The Fund permits the 
examination to begin with the deed into the developer of condominium property, 
provided that the declaration of condominium has been of record for seven or more 
years. 

Using Declaration of Condominium As Title Base

6. Perform a DEEDS search 
on several lots close to the 
subject lot, then review the 
printout and select a lot 
that has been conveyed by 
the developer.

7. Perform a full property 
search on the selected lot. 
Start with the recording 
date of the plat.

8. Review the printouts for 
any documents that would 
confirm there are liens or 
encumbrances not
identified in the search of 
the underlying or subject 
property. Order hard copies 
of documents that may 
apply.

What You Do Comments
1. Use the Plat Information 

From Plat Name
transaction to verify that 
the source of plat date for 
the condominium is at least 
seven years old.

If the declaration of condominium has not 
been of record for at least 7 years, it may not 
be used as a base title for examination 
purposes.

2. Order a copy of the 
declaration of 
condominium.

What You Do Comments
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3. Determine the underlying 
legal description of the 
condominium.

This and the following steps assume that the 
declaration of condominium has been of 
record for seven or more years.

4. Identify the date of the 
deed into the condominium 
developer by performing a 
DEEDS search on the 
underlying property and 
review the property search 
printout.

5. Perform full property 
searches on both the 
subject property and the 
related underlying 
property. Start the search 
on the underlying property 
with the recording date of 
the deed into the developer. 
Start the search on the 
subject property with the 
recording date of the 
declaration of 
condominium and order 
hard copies of the 
documents that are not 
eliminated.

6. Perform a DEEDS search 
on the condominium, then 
review the printout and 
select a unit that has been 
conveyed by the developer.

7. Perform a full property 
search on the selected unit. 
Start with the recording 
date of the declaration of 
condominium.

What You Do Comments
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8. Review the printouts for 
any documents that would 
confirm there are liens or 
encumbrances not
identified in the search of 
the underlying or subject 
property. Order hard copies 
of documents that may 
apply.

What You Do Comments
Training Workbook Version: 081711 Page 107



Lesson 2 - Obtaining Base Title Information
Ordering A Prior Policy
The Prior Policy Order transaction is used to order a hard copy of a prior Fund or 
ORNTIC/ATFS policy when issuing an ORNTIC/ATFS policy. A TITLE or Interval 
Yes file must be opened and the property search performed in a Subdivision/
Condo Search transaction or Acreage/Govt Lot Search transaction before 
ordering a prior policy.

What You Do Comments
1. From the Search Menu

Confirm that the County
field shows Manatee.

If it does not, select Manatee county from 
the drop down box.

2. Confirm that the File 
Name/No. shows the 
correct information.

If it does not, type [Your File Number]

3. Click the Policy Search 
and Order button.

The Policy Search and Order screen is 
displayed. Your file number should be 
displayed with the legal information 
previously entered.
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4. Click the Next button. A summary of the prior policies found for the 
search is displayed.

5. Click the Next button. The prior policy search results are displayed 
with the detailed policy information.

What You Do Comments
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6. Select OP for the Owner's 
Policy by clicking in the S
box.

Note: S is for Select; R for Released. When 
possible, use the Owner's Policy as the base 
title. If a prior Owner's Policy is not available, 
then use a prior Mortgagee Policy. However, 
the Search From Date on the Property 
Search performed will need to start from the 
recording date of the deed into the mortgagor.
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7. Click the Customer 
Information button.

The Delivery Information screen is 
displayed.

8. Place the cursor in the first 
Phone field and type 407
then press TAB and type 
555 then press TAB and 
type 5000.

Note: Use the TAB key to navigate through 
the Phone field.

9. Place the cursor in the first 
Fax field and type 407
then press TAB and type 
555 then press TAB and 
type 5001.

Note: The Fax field is a required field if the 
Delivery By field is set to Fax.

10. Tab to the Ordered By
field and type [Your 
Name]

 

11. Tab to the Responsible 
Party field and type 
Richard Bruce.

Richard Bruce is the party responsible for the 
charges, because he has asked his Paralegal to 
order the prior policy.

12. Tab to the Deliver By
field and select the delivery 
method desired.

Note: When ProPel® is enabled, it will default 
to the ProPel delivery method.
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13. Click the Release Order
button.

The prior policy order is released to the prior 
policy order department and a confirmation 
sheet is printed in the Fund member's office. 
An order number is provided. Note: If the 
legal on the policy does not match the legal on 
the property search, an error message will 
appear and the order will not be released.

What You Do Comments
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         Sample of Prior Policy Order Confirmation
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Order Branch Products
Use the Order Branch Products transaction to order products from a Fund branch. 
For the purposes of this exercise, a Chain ATIDS Pre-Computer product will be 
ordered.

What You Do Comments

1. From the Policy Search 
window select Search 
Menu. From the Search 
Menu select Main Menu.
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2. From the Main Menu, 
select Order Branch 
Products

The Branch Product Order - Product 
Selection screen is displayed.

3. Select Product 14 in the 
Product Codes section.

The Product Codes are listed in alphabetical 
order. Note: Click the More Products button 
to page forward to view more Product Codes.

4. Click the Submit button. The first Order screen is displayed.
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5. Choose the appropriate 
answer to the Policy 
Intent field. 

In this exercise, choose Y (yes). 

6. Type 03261985 in the 
Search From Date field.

This is usually the effective date of the prior 
policy being used as the base. Note: This 
information is listed on the prior policy search 
printout.

7. Tab to the Document 
Recording Ref field and 
type OR, tab to the Book
field and type 1107, and 
then tab to the Page field 
and type 966.

The recording reference of the deed is added. 
Note: This information is listed on the prior 
policy search printout.

8. Tab to the Underwriter
field in the Prior Policy
section and type ATIF.

Type the name of the underwriter.

9. Tab to the Type field and 
type OP, and then tab to 
the Number field and type 
521058.

Note: This information is listed on the prior 
policy search printout.
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10. Click in the Legal 
Description field and 
type LOT 21, 
UNIVERSITY PINES, 
PB 22/65. 

11. Click the Next button. The second Order screen is displayed.

What You Do Comments
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12. Type [Your file number]
in      the File Name/No.
field. 

13. Type the desired business 
date in the DATE 
NEEDED BY field. 

Note: The Special Instructions field can 
be used to request e-mail delivery of the 
product and to provide the order specialist 
with any additional specific instructions.
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14.  Click the Next button. The third Order screen is displayed.

15. Verify Order 
Information.

Note: For DoubleTime users that wish to 
receive a Fund Data File, click the Y options 
button for certain products.

16. Type [Your Name] in the 
Order By field. 

This is a required filed.

17. Click Release Order
under options section

Your order will be released to the branch.
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                        Sample Branch Product Receipt
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Lesson 3 - Problem Solving
Lesson 3 - Problem Solving

Concept
In this lesson, you will use the ATIDS system to obtain a complete legal description 
using a partial legal description. You will also learn how to change the current search 
county and determine a correct or valid legal description.

Objectives
• Change the search county.
• Obtain the recording reference and posting information.
• View authorized legal designations of a plat.
• View the legal description a property document is posted to in the ATIDS 

system.

Transaction Information
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View/Change County
Use the View/Change County transaction to change to a different county or to 
verify the Current Search County. To obtain the correct property, name, and tax 
information, the system should be first set to the correct county.

Changing The On-Line County

What You Do Comments

1. From the Main Menu, 
click the Change County 
button.

The View/Change County screen is 
displayed.
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2. Select Miami-Dade
county from the Current 
Search County drop-
down selection box.

3. Click the Update County
button.

The Current Search County changes to 
Miami-Dade county.

What You Do Comments
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Plat Information From Plat Name
Use the Plat Information From Plat Name transaction to obtain the plat reference 
for subdivisions and condominiums. This transaction is very helpful when the plat 
reference is missing or incorrect and to resolve the ATIDS error message "errors 
detected, correct and re-enter". This error message will occur as a result of an 
invalid plat reference for a subdivision/condominium when performing a search. By 
typing in the name of the subdivision or condominium, the system will display the plat 
reference, along with the date of the plat or declaration of condominium.

Obtaining The Recording Reference For Subdivisions/Condominiums

4. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.

What You Do Comments

1. From the Main Menu, 
click the Plat 
Information From Plat 
Name button.

The Plat Information From Plat Name
screen is displayed.

What You Do Comments
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2. In the Subdivision/
Condo       Name field, 
type MAR AZUL and then 
click the Submit button.

The Subdivision/Condominium Name, 
Source of Plat, Book, Page, Levels, and 
Plat Date are displayed. Note: The Source 
of Plat for Mar Azul Condominium is OR, 
the Book is 8791 and the Page is 1293.

3. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.
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View Sub/Condo Legals
The View Sub/Condo Legals transaction is used to find the authorized legal 
designations for subdivisions and condominiums, i.e. lots, blocks, units, etc. This 
transaction is very helpful when trying to determine the correct legal description for 
the property and to resolve the error message "invalid search argument", which 
occurs as a result of an invalid search.

Locating Authorized Legals For Subdivisions/Condominiums

Tips:
• When typing in the subdivision/condo name, omit the words "subdivision" 
and "condominium".  If this is not part of the recorded name, the ATIDS system 
will display the "subdivision master record not found" message.
• When typing in the subdivision/condo name, omit any directional words such 
as “North, South, East and West.”
• If you are not certain of the spelling of the name, shorten the name and type a 
? to represent all endings to a word. Example: type BOUG? to find all words 
that begin with BOUG, i.e. Bougainvillea, Bougenvista, etc.
• If print is desired, click the Print button under the Options section.

What You Do Comments

What You Do Comments
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1. From the Main Menu, 
click the View Sub/
Condo Legals button.

The View Sub/Condo Legals screen is 
displayed. Note: The Source of Plat field 
defaults to PB-Plat Book. Other sources 
are available for selection in the drop-down 
selection box. 

2. Change the Source of 
Plat field to OR-Official 
Records.

The Source of Plat for the Mar Azul 
Condominium is the Official Records Book 
for Miami-Dade County. 

3. Tab to the Book field and 
type 8791.

Note: The Source of Plat for Mar Azul 
Condominium is OR, the Book is 8791 and 
the Page is 1293.

4. Tab to the Page field and 
type 1293.
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5. Click the Submit button. The authorized legal designations are 
displayed. Note: The range of Levels for Mar 
Azul Condominium are displayed as they 
should be used in other transactions that 
require this information, such as
Subdivision/Condo Search option on the 
Search Menu. 

6. Click the Next button. The next screen of information is displayed.

What You Do Comments
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7. Continue to click the Next
button until the unit that 
pertains to the property 
being searched is 
displayed. 

Note: (1) ATIDS indicates that Unit 10B of 
North Mar Azul Condominium is to be 
entered in the Subdivision/Condo Search
option in the Search Menu as 10BN in the 
L1 Lot/Unit field. (2) If print is desired, 
select the Print option from the File menu. 

8. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.
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Authorized Codes/Levels
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Document Posting Information
The Document Posting Information transaction is a support transaction which 
allows the display of property and name document information. This is helpful when 
trying to determine the parties on a property or name document, or to view which legal 
description a property document is posted to in the ATIDS system.

The following Warranty Deed will be used to determine the legal description that the 
document is posted to in the ATIDS system.
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Obtaining The Posting Information

What You Do Comments

1. From the Main Menu, 
click the Document 
Posting Information 
button.

The Document Posting Information 
screen is displayed. Note: Document 
Posting Information will only display 
information for documents within on-line 
time.
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2. The Primary Reference
field defaults to OR-
Official Records.

The document is stamped indicating that the 
Primary Reference is OR for Official 
Records. Note: Other choices are available 
by selecting the arrow on the drop down box 
for Primary Reference.

3. Leaving the default 
selection of OR- Official 
Records, Tab to the Book
field and type 16048.

4. Tab to the Page field and 
type 83.

5. Click the Submit button. The Search Results screen containing the 
document information is displayed. 
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6. Click the Legal Posting 
Information button under 
the Options section, or 
the Next Category button 
on the top of the screen.

The Legal Posting Display screen is 
displayed, containing the posting information 
for this document. Note: (1) The information 
on this screen is used to perform the property 
search. (2) To print, use the Print button in 
the Options section. (3) Click the New 
Document Search button to return to the 
Document Posting Information screen to 
perform a new search.(4) You may receive a 
Re-Plat Warning. Make sure to contact the 
Fund Branch that services that county.

What You Do Comments
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Try This
What you Do Comments

1. Search Menu > Add/
Change/Find File

Open a new file.

2. Run Prior Policy 
Search

To obtain a starting search date.

3. Search Menu > 
Subdivision/Condo 
Search

Search the Mar Azul property

7. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.
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Lesson 4 - Acreage
Lesson 4 - Acreage

Concept
In this lesson, you will learn to perform a property search on an unplatted legal 
description. You will also determine the section breakdown codes and learn how to 
limit your search to a specific document type.

Objectives
• Change the search county.
• Obtain the acreage codes.
• Open an ATIDS file.
• Perform a search for a satisfaction of a mortgage on the property.

Transaction Information
You have the following mortgage, and you wish to determine if there is a recorded 
satisfaction.
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View/Change County
Use the View/Change County transaction to change to a different county or to 
verify the Current Search County. To obtain the correct property, name, and tax 
information, the system should be set to the correct county.

Changing The On-Line County

What You Do Comments

1. From the Main Menu, 
click the Change County 
button.

The View/Change County screen is 
displayed.
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2. Select Alachua county 
from the Current Search 
County drop-down 
selection box.

3. Click the Update County
button.

The Current Search County changes to 
Alachua county.

What You Do Comments
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4. Click the Main Menu
button under the Options
section.

The Main Menu is displayed.
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Document Posting Information
The Document Posting Information transaction is a support transaction which 
allows the immediate display of property and name document information. This is 
helpful when trying to determine the parties on a property or name document, or to 
view the acreage codes a property document is posted to in the ATIDS system or how 
to search the property in the ATIDS system.

Obtaining The Posting Information

What You Do Comments

1. From the Main Menu, 
click the Document 
Posting Information 
button.

The Document Posting Information 
screen is displayed. Note: Document 
Posting Information will only display 
information for documents within on-line 
time.
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2. The Primary Reference
field defaults to OR-
Official Records.

The document is stamped indicating that the 
Primary Reference is OR for Official 
Records. Note: Other choices are available 
by selecting the arrow on the drop down box 
for Primary Reference.

3. Leaving the default 
selection of OR- Official 
Records, Tab to the Book
field and type 1700.

Note: The document is stamped indicating 
that the Primary Reference field in Alachua 
County is OR for Official Records.
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4. Tab to the Page field and 
type 282.

5. Click the Submit button. The Search Results screen containing the 
document information is displayed. 

6. Click the Legal Posting 
Information button under 
the Options section.

The Legal Posting Display screen is 
displayed, containing the posting information. 
For this document, the legal description is 
posted using acreage codes.
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                                              Sample Document Posting Information Printout

7. Click the Print button. The results are printed. Note: The information 
on this screen is used to perform the property 
search.

8. Review the Document 
Posting Information
printout.
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Document Name Posting Information
For this exercise, use OR Book 1704, Page 1681 in Alachua County to obtain the 
names associated with the document.

Obtaining The Posted Name Information

What You Do Comments

1. The Primary Reference
field defaults to OR-
Official Records.

The document is stamped indicating that the 
Primary Reference is OR for Official 
Records. Note: Other choices are available 
by selecting the arrow on the drop down box 
for Primary Reference.
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2. Leaving the default 
selection of OR- Official 
Records, Tab to the Book
field and type 1704.

Note: The document is stamped indicating 
that the Primary Reference field in Alachua 
County is OR for Official Records.

3. Tab to the Page field and 
type 1681.

4. Click the Submit button. The Name Document Display screen 
containing the document information is 
displayed. 
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Tips:
• Click the Print button under the Options section to print the results.

• To perform a new search, click the New Document Search button. The 
Document Posting Information screen is displayed..Click the Print button 
under the Options section to print the results.

• Displayed on this example, this name document's Type of Instrument is a 
MAN, which is a Mandate. For a complete list of Type of Instrument 
Codes, see “ATIDS Reference Tables”
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Add/Change/Find File 
The Add/Change/Find File transaction is used to add an ATIDS file. A separate 
ATIDS file number must be added for each new closing transaction. The proper bill 
code must be assigned to the file in this transaction. The Add/Change/Find File
transaction also allows the change of certain file related information and the scan of 
files in the ATIDS account.

Adding A New File

What You Do Comments
1. From the Name 

Document Display 
Menu, click the Search 
Menu button.

The Search Menu is displayed. Confirm 
that Alachua is the selected County for the 
search. If it is not, change the County to 
Alachua by using the pull down box available 
in the County field. 

2. Tab to the File Name/No.
field and type [You File 
Number]

The File Number can be up to 15 characters, 
digits, or a combination of characters and 
digits.

3. Click the Add/Change/
Find      File button.

The Add/Change/Find Files screen is 
displayed.
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4. Verify the file number. Note: The Function field defaults to the Add
function. There are two other Functions
available at this time: Change and Find. Use 
Change to change the description, Bill 
Code, or Policy Intent question in an 
existing file. Use Find to locate a File 
Name/No.

5. Click the Submit button. The next screen to add a file will display.

6. Type [Your Name] in the 
Ordered By field. 

Note: The Ordered By field is a required 
field and will appear on the account's billing 
activity report.
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7. Tab to the Description field 
and type TURLINGTON 
SATISFACTION

A description of the file is placed in this field. 
Note: The Description field is a required 
field and will appear on the account's billing 
activity report.

8. Tab to the Bill Code field 
and select Satisfaction 
of Liens from the drop-
down box.

The Bill Code selected here determines the 
cost of the file as well as the results of the 
property search. Note: The Bill Code field 
defaults to Title Search.

9. Click No as the answer to 
the Policy Intent
question.

A No answer denotes that there will not be an 
ORNTIC/ATFS policy issued. Note: (1) The 
default is set to a Yes answer. (2) Bill By 
Usage codes may never be used when 
answering the question Yes.
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10. Click the Enter/Return 
to Search Menu button 
under the Options
section.

You are returned to the Search Menu. The 
file has been added. Note: The File Name/
No. field contains the name of the file that 
was just added.
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Bill By Usage Codes - Uncertified Information
Table 1: 

Bill Code Rate Open Conditions For 
Use

Legal-Per 
Search $10.00* 1 mo

Used for an 
uncertified legal 
description search.

Deeds Only 
Search $2.25* 1 mo

Used for determining 
the owner of a 
property.

Liens Only 
Search $2.25* 1 mo

Used for obtaining 
lien instruments 
posted to a property.

Mortgages 
Only Search $2.25* 1 mo Used for locating or 

comparing mortgages.

Name-
Per Search $2.25* 1 mo Used for 20-year 

judgment search.

Satisfaction of 
Liens $2.25* 1 mo

Used for locating 
mortgage-related 
satisfactions, 
assignments, releases, 
and partial releases.

 Note: (1) *For each legal searched, every time it is searched. (2) When 
calling the Help Desk use the customer number. Copies of documents related 
to an ATIDS file are free, except when using the Legal bill code. There is a 
$1.00 charge per page to obtain these documents if you are not using ProPel 
as your delivery method. For ProPel, the charge is $0.60 per document.
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Acreage/Govt Lot Search
Use the Acreage/Govt Lot Search transaction to perform searches on acreage legal 
descriptions (unplatted land). This search will require the acreage section breakdown 
codes, which can be obtained by mapping out the legal description, utilizing the 
Document Posting Information transaction, or by contacting a Fund branch.

Performing An Acreage/Government Lot Property Search

What You Do Comments

1. From the Search Menu, 
click the Acreage/Govt 
Lot Search button.

The Acreage/Govt Lot Search screen is 
displayed.
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2. Type 05261988 in the 
Search From Date field.

May 26, 1988 is the date the mortgage was 
filed and when the property search should 
begin.

3. Tab to and type 17 in the 
Section field.

4. Tab to and type 08 in the 
Township field.

5. Tab to and type 19 in the 
Range field.

6. Tab to the S or G field and 
select Section Code
from the drop-down 
selection box.

Note: For government lots, select 
Government Lot from the drop-down 
selection box.

7. Tab to and type 133 in the 
Code field.

133 is the first acreage code for the property 
found on the Document Posting 
Information printout.

What You Do Comments
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8. Tab to the next S or G
field and select Section 
Code from the drop-down 
selection box.

There are two acreage codes for this property.

9. Tab to and type 333 in the 
Code field.

333 is the second acreage code for the 
property found on the Document Posting 
Information printout.

10. Click the Submit button. The property search is performed. The 
number of instruments found for the search is 
displayed at the top of the screen.
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11. Click the Deliver Search 
Results button.

The search results are printed and the Search 
Menu is displayed.

12. Review the printed 
Search Results. 

Note: The results state: “*THIS IS A 
RESTRICTED SEARCH. IT MAY NOT 
BE USED TO WRITE A TITLE 
POLICY*” 

This is due to the Bill Code chosen. 
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                                                              Sample of NON-Certified Search

Printout continued on next page...
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                                                     Sample of NON-Certified Search

Printout continued on next page...
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                                                     Sample of NON-Certified Search

Printout continued on next page...
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                                                       Sample of NON-Certified Search

Printout continued on next page...
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                                                        Sample of NON-Certified Search

Printout continued on next page...
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                                                     Sample of NON-Certified Search

Printout continued on next page...
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                                                        Sample of NON-Certified Search

Printout continued on next page...
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                                                 Sample of NON-Certified Search

Printout continued on next page...
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                                                   Sample of NON-Certified Search
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Guidelines for Eliminating Instruments
When examining an ATIDS property printout that contains lengthy metes and bounds 
descriptions on parcels adjacent to or within the same section code as the parcel being 
examined, you do not need to map legal descriptions on certain documents if you are 
issuing an Old Republic National Title Insurance Policy through ATFS. You may rely 
on the names of parties to form a chain of title.

Lengthy Metes and Bounds Descriptions
• Starting with the effective date of the property search, review the search 

printout and identify the deed into the current owner.
• Identify all other deeds that form the chain of title into the current record 

owner.
• Map the legal description on the deed of the first owner of the property or 

compare the legal description on the deed of the first owner with description of 
the property to be insured.

• Identify mortgages, satisfactions/releases of mortgages, mortgage-related 
documents, property liens, and satisfactions of liens for all owners in the chain 
of title.

• Eliminate all other deeds, liens, mortgages, and mortgage-related documents 
that do not include the name of any owner in the chain of title.

• Eliminate mortgages/liens executed by any owner in the chain of title that 
appear satisfied of record based on the property search. See “Guidelines for 
Eliminating Instruments” on page 48.

• Eliminate documents that relate to the satisfied liens/encumbrances.
• Order all other documents on the property printout that affect the property
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Lesson 5 - Additional Transactions

Concept
In this lesson you will learn to use additional transactions available in the ATIDS 
system. Please refer to the ATIDS manual for a more detailed explanation of these 
transactions.

Objectives
• Obtain billing activity.
• Report the 1099-S information through ATIDS.
• Report possible posting errors.
• Search for prior policies for unplatted (acreage) property.
• Obtain real estate tax information when an ATIDS file is not being used.

Transaction Information

Description Transaction Information

1099 Exercise
Seller:  Jean Luc Leblanc
Seller Forwarding Address: 325 Banyan Drive, Boca Raton, FL 33431
Seller SS#: 225-75-7935
Street Address of Property: 154 Santa Monica Avenue, Royal Palm 

Beach, FL 33411
Gross Proceeds Amount: $150.000.00
Policy Type & Number: OF6 8510863
Closing Date: February 1, 20CY (CY = Current Year)

Prior Policy Exercise
Legal Description: East Half of Southeast Quarter of Southeast 

Quarter (E ½ of SE ¼ of SE ¼) of 
Section 17, Township 8 South, Range 19 East, 
Alachua County, Florida. (Acreage codes - 
133 and 333).

Tax Search Exercise
Street Address: 3029 Brickell Avenue, Miami, Fl
Property Appraiser TIN: 4204-001-0330
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Billing Activity Menu
Use the Billing Activity Menu transaction to display/print the billing activity for the 
account. This will allow the printing of the invoice so that it can be sent in for 
payment. This transaction also includes an adjustment menu to submit request for 
adjustment to the account without calling the Help Desk. There is one year of billing 
data maintained in the system.

Monthly Summary

What You Do Comments

1. From the Main Menu, 
click the Billing Activity 
Menu     button.

The Billing Activity Menu screen is 
displayed.
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2. Click the Summary by 
Month button.

The Summary by Month screen is 
displayed.

.

3. In the Summary by 
Month field, type the 
month and year desired. 
(MMCCYY - CY= Current 
year)

4. In the Delivery Options
field, select the Both
option.

To Display only, select Display. To Print 
without displaying first, select Print.
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5. Click the Submit button. The results are displayed and are also printed. 
Page numbers can be changed to advance to a 
specific page within the range by using the 
Goto Page field. The charges and individual 
invoice information are provided
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Detail By File

Note: The last page of the Billing Activity Summary will contain a summary 
with a monthly subtotal.

6. Click the Bill Menu
button.

The Billing Activity Menu screen is 
displayed.

What You Do Comments

1. Click the Detail by File
button. 

The Billing Activity Detail by File screen 
is displayed.
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2. Choose the appropriate 
Delivery Options.

Display produces screens to be reviewed 
online. Print sends the results to the printer 
without the opportunity to view them first. 
Both simultaneously generates screens for 
viewing and printouts.

3. Enter the File Name/
Number information and 
click the Submit button.

The Detail screen is displayed for the file 
selected. Note: (1) All searches will be 
displayed for the file. (2) To obtain the 
equivalent of the monthly detail report 
previously sent by The Fund, enter the month/
year for the month desired and select Detail 
Billing Activity.

4. Click the Bill Menu
button.

The Billing Activity Menu screen is 
displayed.
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Invoice By Day

What You Do Comments

1. Click the Invoice by Day
button. 

The Billing Activity Invoice by Day
screen is displayed.

2. Choose the appropriate 
Delivery Options.

Display produces screens to be reviewed 
online. Print sends the results to the printer 
without the opportunity to view them first. 
Both simultaneously generates screens for 
viewing and printouts.
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3. In the Activity Date field 
enter the appropriate date 
and click the Submit
button.

The Invoice screen is displayed for the file 
selected. Note: (1) Click on the Last Page
button to view the invoice total

4. Click the Bill Menu
button.

The Billing Activity Menu screen is 
displayed.
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Adjustment Request

What You Do Comments

1. From the Billing Activity 
Menu click the 
Adjustment Request
button.

The Billing Activity Adjustment 
Request screen is displayed.

2. Choose the appropriate 
Delivery Options.

Display produces screens to be reviewed 
online. Print sends the results to the printer 
without the opportunity to view them first. 
Both simultaneously generates screens for 
viewing and printouts.
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Tips
• To obtain the equivalent of the monthly detail report previously sent by The 

Fund, select the Detail Billing Activity option and enter the Month/Year for the 
month desired.

• The Fund will continue to send a consolidated monthly statement for only 
Open/Unpaid items.

• The Billing Activity transaction contains one year's worth of history.
• Billing charges will appear the day after a charge has been incurred.
• Date Range criteria allows any variation of a maximum of 31 days.

3. In the Adjustment 
Request field enter the 
appropriate File Name/
Number and click the 
Submit button.

Note: Follow transaction instructions for the adjustment desired.
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IRS 1099-S Reporting
The IRS 1099-S Reporting transaction is used to report real estate transactions to 
The Fund. It is the member's responsibility to key in the accurate information about 
the real estate transaction being reported. The Fund forwards all reports to the IRS.
Note: For any questions regarding 1099 reporting, you may refer to the December 
2010 Fund Concept article 1099-S Reporting written by John Benson. 

Reporting 1099-S Information

What You Do Comments

1. From the Main Menu, 
click      the IRS 1099-S 
Reporting       button.

The IRS 1099-S Reporting screen is 
displayed.
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2. In the Function field, 
select Add 1099-S 
Information from the 
drop-down selection box

To display a 1099-S information record select 
Display, to change a 1099-S information 
record select Change, to delete a 1099-S 
information record select Delete.

3. Tab to the Customer No. 
field and type 899900

899900 is used for training purposes only. Be 
sure to add the Fund member number 
assigned to the firm.

4. Tab to the File Name/No. 
field and type [Your file 
number]

Key in a unique file number for the real estate 
transaction. A unique file number is required 
by the IRS.

5. Click the Submit button. The IRS 1099-S Reporting screen is 
displayed
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6. In the Underwriter field 
choose the title insurance 
underwriter insuring the 
transaction from the 
drop-down selection box.

Note: The default selection is ORNTIC 
processed by ATFS. The drop-down 
selection box has a list of other underwriters. 
If no title insurance was issued, select No 
Underwriter. 

7. Tab to the Form Type
field and type OF6.

This is the abbreviation for the 2006 ALTA 
Owner’s Policy. 

8. Tab to the Commitment/
Policy Number field and 
type 8510863.

Type the commitment or policy form number. 
Type NONE if no title insurance was issued. 
Note: ORNTIC commitments are no longer 
serialized.

9. Tab to the Address field 
in the Property 
Information section and 
type 154 SANTA 
MONICA AVE. 

A brief legal description can also be used.

10. Tab to the City field and 
type ROYAL PALM 
BEACH.

11. Tab to the State field and 
type FL.

12. Tab to the Zip field and 
type 33411.

13. Tab to the Name field in 
the Seller Name and 
Forwarding 
Information section and 
type JEAN LUC 
LEBLANC.

Note: Only one name can be added in this 
field. When the sellers are a husband and 
wife, type the husband's name, unless 
otherwise stated by the sellers.

14. Tab to the Address field 
and type 325 BANYAN 
DRIVE.

325 Banyan Drive is the forwarding address 
for Jean Luc Leblanc.

15. Tab to the City field and 
type BOCA RATON.

16. Tab to the State field and 
type FL.

Note: Omit the state abbreviation if the seller's 
forwarding address is not in the U.S. and use 
the Country Code field.
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17. Type 33431 in the Zip
field.

Note: The Country Code field can be left 
blank if the seller resides in the US. If the 
seller resides outside the US, refer to 
Appendices in the ATIDS manual for the 
correct Country Code.

18. Tab to the Social 
Security       Number/
Tax ID field and type 
225-75-7935. 

19. Tab to the Gross 
Proceeds      Amount
field and type 150,000.

The total sales price of the property sold is 
added. Note: (1) If there are multiple sellers, 
this amount is only the individual seller's 
portion displayed on the current screen. (2) 
The Buyer's Real Estate Tax Amount
field is only filled in if the seller has paid the 
Real Estate taxes in November or December 
and there is an amount due to the seller from 
the buyer. This amount is found in the 400 
series of the HUD-1 settlement statement.

20. Tab to the Exchange
field.        This field 
defaults to N for No.

If money was not used for a portion or all of 
the real estate transaction, select Y.

21. Tab to the Closing Date
field   and type 020120CY
(CY=current year). Do not 
use slashes (/).
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22.  Click the Submit button. The Record Added message is displayed.
t

Note: (1) To add an additional seller, click the Add Additional Seller button 
under options and type the next seller's information. There is no limit to the 
number of sellers. (2) To return to the IRS 1099-S Reporting screen to add 
another record, click the Print/1099-S Report button. The 1099-S 
Reporting screen is displayed and the record is printed. (3) It is the 
responsibility of the reporting Fund member to provide the seller with a copy of 
the information reported to the IRS. The Fund only transmits information to the 
IRS, not to sellers.
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Tips:
• For any questions regarding 1099 reporting, you may refer to the December 

2010 Fund Concept article 1099-S Reporting written by John Benson.

                                                Sample of 1099-S Printout

23. Review the IRS 1099-S 
printout for accuracy.
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Report Document Error
The Report Document Error transaction allows a Fund member to report possible 
posting errors by The Fund which appear on the ATIDS printouts. The Fund will 
research the reported errors and if necessary make any corrections. The Report 
Document Error transaction assigns a posting alert reference number.

Reporting Posting Errors

What You Do Comments

1. From the Main Menu, 
click      the Report 
Document Error
button.

The Report Document Error screen is 
displayed.
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2.  Type [Your Name] in the 
Requested by field.

The Fund will contact the Fund member to 
notify the outcome of the research.

3. Tab to the Area Code/
Phone Number field and 
type 407 555 5000.

Use the Tab key to navigate from one field to 
the next.

4. Tab to the E-Mail field and 
type Your E-mail 
address 

5. Tab to the County field 
and select the county from 
the drop-down selection 
box. For the      purposes of 
this exercise, select 
Miami-Dade.

Note: Select the county corresponding to the 
property or name document.

6. Tab to the Recording 
Reference field and type 
OR 1307/378. 

If the primary reference is not available, key 
in the secondary reference (Clerk's file 
number and year).
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7. Tab to the Nature of 
Problem field and type a 
description of the 
problem and the file 
number of the file. For the 
purposes of this 
exercise, type Mortgage 
should be posted to 
Lot 10, Block 1, PB 15/
24; not Lot 10, Block 11 
File # AB-123. *** 
TRAINING - PLEASE 
DO NOT PROCESS ***

Explain the problem and how the document 
should be corrected. Note: Text will not wrap 
down. Tab to additional fields for text as 
needed.

8. Click the Submit button. Note: A Posting Alert Reference 
Number is automatically assigned.
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9. Click the Print button 
under the Options 
section.

The Posting Alert Request is printed.

10. Click on the Main Menu
button under the Options
section.

The Main Menu screen is displayed.

What You Do Comments
Page 186 Web ATIDS Ver. 3.2



Lesson 5 - Additional Transactions
Policy Search - Acreage
Use the Search Menu/Policy Search and Order transaction to search for prior 
Fund, NATIC, and ORNTIC/ATFS title policies for acreage or government lots by 
entering the breakdown codes and the section-township-range of the property. 
Information messages, along with the number of legals found, are displayed. Prior 
Fund policies are indexed from 1948. Prior NATIC policies are indexed from 1980 
through 1989. Prior ORNTIC/ATFS policies are indexed from 2009. Prior policies 
can only be obtained when ordered directly through ATIDS and when opening a 
TITLE Yes file. This is not required to SEARCH for prior policies.

Finding Prior Policies For Acreage

What You Do Comments

1. From the Main Menu, 
click    the Search Menu
button.

The Search Menu is displayed.
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2. Select Alachua county 
from the drop-down 
selection box.

3. Click the Policy Search 
and Order button.

The Policy Search Policy Legal Entry
screen appears. Note: A file number is not 
required when searching for prior policies. 
However, in order to save results, a file 
number is required.
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4. In the Section field type 
17

5. Tab to the Township field 
and type 8 and select S.

Note: Township field and Range field will 
have a drop-down selection box to select N 
for North, S for South, E for East and W for 
West, accordingly.

6. Tab to the Range field and 
type 19 and select E.

7. Tab to the S or G field and 
select Section Code.

Note: This exercise contains a section code 
breakdown. If the legal description contains a 
government lot number, be sure to search the 
Government Lot number and the Section 
Code Breakdown.

8. Tab to the Code field and 
type 33.

Using acreage code 33 will find all prior 
policies for the SE ¼ of the SE ¼, which 
would include acreage codes 133 and 333.
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9. Leave the Search From 
Date and Through Date
fields at their default 
values. Click the Next
button.

The Policy Search results screen is 
displayed. The prior policy search results are 
displayed with detailed policy information. 
Policies cannot be selected at this time. Note: 
If needed the Search From Date and 
Through Date fields may be edited to adjust 
the search parameters.

10. Click the Next button. The prior policy search results are displayed 
with detailed policy information. 
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11. Click the Next button. The next page of results is displayed.

12. From the File menu select 
Print.

The active screen prints.

13. Return to Main Menu.
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Note: (1) Prior policies are listed in chronological order with the most recent 
policy displayed at the top. Use the Search Menu/Policy Search and 
Order transaction to order a hard copy of the prior policy. Remember: A 
TITLE Yes file MUST be open and the property search must be performed in 
the file prior to ordering a prior policy in the Order Policy transaction. (2)
Select the Print option from the File menu to print the active screen.
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Tax Search - Non File Related
The Tax Search - Non File Related transaction has two options. The Tax Search 
Option is used to obtain ad valorem real estate tax information. The Taxpayer/
Address Search Option is used to obtain taxpayer's name, address, and property 
legal description. Use the Tax Search - Non File Related transaction when you do 
not have an established ATIDS file with a Bill By File code. 

Using the Tax Search Option

What You Do Comments

1. From the Main Menu, use 
the Change County 
transaction to update the 
county to Miami-Dade.

The property to be researched is located in 
Miami-Dade County. You must be in the 
correct county to obtain the tax information.
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2. From the Main Menu, 
click the Tax Search - 
Non File     Related
button.

The Parcel/Name Information Display
screen is displayed.

3. Click the Tax Search
button.

The Special Notices screen is displayed. 
Note: If a printout of the tax information is 
desired, select the Yes button on the Print 
Desired question.
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Note: In some counties the Special Notices
screen       is displayed. It is important to read 
the special tax information for the county 
being searched. This information is included 
on the tax printout.

4. Click the Next button. The Tax Search Inquiry screen displays.
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5. In the File Name/No.
field, type the file reference 
number.

Type a file number to identify the tax 
searches.

6. Tab to the Folio/Tax I.D. 
No. field and type 4204, 
tab and type 001, tab and 
type 0330.

The folio number is the tax ID number for a 
specific property.

7. Click the Search by 
Folio/Tax ID No. button.

The Parcel/Name Identification screen is 
displayed.
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8. Click the Next button.

9. Click the Next button.
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10. Click the Print button 
under the Options 
section.

All the tax information is printed.

11. Review the tax search 
printout.

Note: Click the Additional Navigation 
button for the Additional Navigation 
Selection Menu
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                                                                 Sample Tax Search Printout 

Printout continued on next page...
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                                              Sample Tax Search Printout

Printout continued on next page...
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                                             Sample Tax Search Printout 

Printout continued on next page...
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                                           Sample Tax Search Printout 

What You Do Comments

12. Click the New Tax 
Search button under the 
Options section. Click on 
the New Tax Search
button, again, to display 
the tax search main menu.

The Search Selection screen is displayed. 
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Tax Search - Non File Related (Continued)

Using The Taxpayer/Address Search Option
What You Do Comments

1. Click the Taxpayer/
Address Search button.

The Taxpayer/Address Search screen 
displays.

2. In the File Name/No. 
field, type the file reference 
number.

Type a file number to identify the tax 
searches.

3. Tab to the Address field 
and type 3029 
BRICKELL AVE.

The taxpayer's name may be typed in the 
Taxpayer Name field as a search criteria. 
Note: When entering the address, only type 
the city, state, or zip code when looking to 
narrow down the search results.  If the record 
is not retrieved, use the property mailing 
address.
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4. Click the Submit button. The Taxpayer/Address Inquiry screen is 
displayed.

5. Click the Print button 
under the Options section

The search results are printed.
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T

6. Review the tax information 
printout.

What You Do Comments
Training Workbook Version: 081711 Page 205



Lesson 5 - Additional Transactions
                                          Sample Tax Information Printout
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What You Do Comments

7. Click the Main Menu
button under the Options
section. 

The Main Menu is displayed.

                    Tax Search - Non File Related Inquiry Rates
Table 2: 

Search Selection Option 
Button Total Cost

Tax information obtained by 
Tax Search Option

Tax 
Search

$7.00

Tax information obtained by 
Taxpayer/Address Search 
Option

Taxpayer/
Address 
Search

$2.00

                       Tax Search - File Related Inquiry Rates
Table 3: 

Search Selection Option 
Button Total Cost

Tax information obtained by 
Tax Search Option

Tax 
Search

$6.00

Tax information obtained by 
Taxpayer/Address Search 
Option

Taxpayer/
Address 
Search

$2.00
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Lesson 6 - Limited Residential Search
Lesson 6 - Limited Residential Search

Concept
In this lesson, you will learn how to perform a Limited Residential Search (LRS). 
The LRS is used to issue an ORNTIC/ATFS Short Form Residential Loan Policy 
(SF6) less than or equal to $500,000 on a completed residential 1-4 family dwelling 
involving fee simple title. The insured property must consist of at least one complete 
lot or condominium unit.

Objectives
• Open an ATIDS file with a Limited Residential Search bill code.
• Perform a Limited Residential Search.

Transaction Information

Description Transaction Information

Borrower: Pierre Hoo-Chong & Renise Hoo-Chong
Property Address: 3349 Calcutta Avenue, Orlando, FL 32817
Loan Amount: $95,000.00
Policy Type: SF6 Short Form Residential Loan Policy
Legal Description: Lot 187, HARBOR EAST, Unit 2, Plat Book 

5, Page 93.
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Search Menu
The Add/Change/Find File transaction is used to add an ATIDS file. A separate 
ATIDS file number must be added for each new closing transaction. The proper bill 
code must be assigned to the file in this transaction. The Add/Change/Find File 
transaction also allows the change of certain file-related information and the scan of 
files in the ATIDS account.

Adding A New File

What You Do Comments

1. From the Main Menu, if 
necessary, use the Change 
County      transaction to 
update the county to 
Orange.

The property to be researched is located in 
Orange County.
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2. From the Main Menu, 
click      the Search Menu
button.

The Search Menu is displayed.The Search 
Menu screen is displayed. Note: The Add/
Change/Find File transaction is used to add 
an ATIDS file. A separate ATIDS file number 
must be added for each new closing 
transaction. The proper Bill Code must be 
assigned to the file in this transaction. The 
Add/Change/Find File transaction also 
allows the change of certain file related 
information and the scan of files in the ATIDS 
account. 
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3. In the County field, 
confirm that the correct 
county is shown, if not, 
select      Orange county. 
and click the Update 
County button.

This transaction involved property located in 
Orange County. Note: When signing-on, the 
system defaults to your home county.

4. In the File Name/No.
field, type the file name/
number for this transaction.

Note: The File Name/No. can be up to 15 
characters, digits, or a combination of 
characters and digits.

5. Choose the Delivery 
Options you want for the 
file. For now, choose 
Display Search 
Results.

To obtain a printout, select Print Search 
Results. To also store the documents in the 
Order Documents transaction, also select 
Send to Document Order Queue. To 
send the search results to ProPel, select Send 
to ProPel Queue. To display the search 
results within the current Web ATIDS session, 
including real time image viewing, select 
Display Search Results. Note: The 
Delivery Options field defaults to Print 
Search Results and Send to Document 
Order Queue. Choosing Display Search 
Results deselects the default selections. 
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6. Click on the Add/
Change/Find File
button.

The Add/Change/Find Files screen is 
displayed.

7. Verify that you have 
entered the correct file 
number. If not you may 
change it before clicking 
the Submit button. 

Note: The Function field defaults to the Add
option. There are 3 options available. The 
Change option is used to change the 
description, Bill Code, or Policy Intent 
question in an existing file. The Find option 
is used to locate an existing file number.

8. Click on the Submit
button.

The next screen needed to add the file 
displays.
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9. Type [Your Name] in the 
Ordered By field. 

Note: The Ordered By field is a required 
field and will appear on the account's billing 
activity report.

10. Tab to the Description field 
and type Hoo-Chong 
Refi.

A description of the file is placed in this field. 
The name of the Borrower will be the 
description for this file. Note: The 
Description field is a required field and will 
appear on the account's billing activity report.

11. Tab to the Bill Code field 
and select Limited 
Residential Search.

The Bill Code selected here determines the 
cost of the file. The Limited Residential 
Search file is open for 12 months at a cost of 
$25. Note: The Bill Code field defaults to 
Title Search. 
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12. Confirm the Yes answer to 
the Policy Intent
question.

In order to use the Limited Residential 
Search Bill Code The Fund member must
issue an ORNTIC/ATFS Short Form 
Residential Loan Policy (SF6). 

13. Click the Submit button. The Limited Residential Search screen is 
displayed.
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Performing The Limited Residential Property Search
The Limited Residential Property Search can be performed from the Search 
Menu or from the Add/Change/Find File transaction. Once the file is identified 
with a bill code of Limited Residential Search, the ATIDS system will 
automatically default to the Limited Residential Search property search screen. 
Only property records for platted legal descriptions such as subdivisions and 
condominiums with the LRS criteria are permitted.
.

What You Do Comments
1. Choose Y to the question 

Issuing Short Form 
Residential Loan 
Policy?.

Entering Y here denotes an ORNTIC/ATFS 
Short Form Residential Loan Policy (SF6) is 
going to be issued as a result of the search.

2. Choose Y to the question 
Policy Amount Less 
Than or Equal to 
$500K?.

Entering a Y here denotes the policy amount 
will be less than or equal to $500,000.

3. Choose Y to the question 
Completed 1-4 Family 
Residential Structure?.

Entering a Y here denotes the closing is for an 
existing residential 1-4 family dwelling 
involving fee simple title, and the property is a 
platted subdivision or a condominium.

4. Choose Y to the question 
Does Property Consist 
Of At Least ONE 
COMPLETE LOT or 
Condo Unit?.

Entering a Y here denotes the property 
consists of at least one complete lot or condo 
unit. Note: The Source of Plat field defaults 
to Plat Book. 

5. Click in the Book field 
and    type 5.

The Book Number for Harbor East Unit 2 is 
5

6. Tab to the Page field and 
type 93.

The Page Number for Harbor East Unit 2 is 
93.

7. Tab to the L1 Lot/Unit
field      and type 187.

Note: This search allows one plat reference 
with up to 6 legals pertaining to the same 
transaction.
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8. Click the Submit button. The property search is performed. The 
number of instruments found will display at 
the top of the screen. Note: Because the 
Display Search Results option was 
selected, no search results are sent to the 
printer at this time. 
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9. Click the Next button. The first page of the search results is 
displayed.

10.  Click on the 
Document Icon in the 
Primary Reference field 
for the document returned. 

Web ATIDS displays the document requested, 
which may be printed, saved, or e-mailed by 
choosing the appropriate button in the 
document viewer window.
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11. Close the document viewer 
window and click the 
Search menu button in 
the Options area.

The Search Menu is displayed. We wish to 
return to the Search Menu in order to choose 
other Delivery Options for the Limited 
Residential Search.

12. This time, choose the
Print Search Results, 
Send to Document 
Order Queue, and Send 
to ProPel Queue
options. 
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13. Click the Subdivision/
Condo Search button.

The Limited Residential Search screen is 
displayed. Note: Web ATIDS has retained the 
search parameters previously entered for the 
file.

14. Click the Submit button. The property search is performed. The 
number of instruments found will display at 
the top of the screen. 
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15. Click the Next button. The Limited Residential Search is printed 
and the Search Menu is displayed. Note:1) 
Because printed search results options were 
selected, the search results are automatically 
sent to the printer. 2)You have completed only 
the property search. A complete search also 
requires a name and a tax search. Use Search 
Menu/Name Search to search the names. 
Use Search Menu/Tax Search (where 
available in WebATIDS) to perform a tax 
search. Use Main Menu/Order 
Documents to order copies of other 
documents, if needed.

What You Do Comments
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16. Review the printout.

What You Do Comments
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                     Sample of Property Printout
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                        Sample of Property Printout

Printout continued on next page...
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                         Sample of Property Printout

Printout continued on next page...
Training Workbook Version: 081711 Page 225



Lesson 6 - Limited Residential Search
                      Sample of Property Printout

Printout continued on next page...
Page 226 Web ATIDS Ver. 3.2



Lesson 6 - Limited Residential Search
                        Sample of Property Printout

Printout continued on next page...
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                           Sample of Property Printout

Printout continued on next page...
Page 228 Web ATIDS Ver. 3.2



Lesson 6 - Limited Residential Search
                         Sample of Property Printout

Printout continued on next page...
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                         Sample of Property Printout
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Search Tips for Limited Residential Search (LRS) Files

Tips:
• If a file contains an incorrect Source of Plat, e.g., Plat or Official Records 

Book and/or Page, an Error Message is displayed. Change the information 
and search again.

• If a file contains the wrong Source, Book and Page and the search runs, call 
the Help Desk for assistance.

• No more than 6 legals may be added to an LRS file.
• A name search and a tax search are required to complete the LRS transaction. 

Use Order Documents Menu to order copies of the documents.
• If a legal description is ineligible for LRS Bill Code, change the Bill Code

to Title or call the Help Desk to cancel the file, and then order a Branch 
product.

• Use the ORNTIC/ATFS Short Form Residential Loan Policy (SF6) jacket only 
when an LRS Search is conducted.
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Lesson 7 - ProPel Additional Features
Lesson 7 - ProPel Additional Features

Introduction
ProPel®, the Fund's electronic document storage and imaging software package, is 
the perfect complement to ATIDS. With ProPel, the Fund can transmit high-quality, 
first-generation images directly to your PC, as opposed to lower-quality fax images, or 
delivery via courier. It provides faster access and easier transfer, plus quicker turn-
around time for your clients - many documents can be transmitted to you in minutes, 
and you can receive Branch Products faster, eliminating courier delay. 
Designed to keep you competitive in today's quickly changing marketplace, ProPel
provides e-mail and export options and gives you the capability to receive, organize, 
and electronically store documents, as well as ATIDS search results. 
ProPel eliminates the need for costly fax and courier services as well as off-site 
storage of real estate files. The Scan feature allows you to add important documents 
into ProPel for electronic storage on a variety of writeable media (such as disks, CDs, 
and network file systems, to name a few) eliminating off-site storage costs. Once you 
begin storing and managing your documents, products, and search results in ProPel, 
the need to maintain actual hard copy storage files can be greatly reduced or 
eventually eliminated.
Features of ProPel® give you the capability to:

• Receive, organize, electronically store, e-mail, and export documents, 
including ATIDS search results.

• Print individual or multiple pages.
• View documents or pages with thumbnails.
• Scan important documents into ProPel for electronic storage, eliminating off-

site storage costs.
• Arrange/rearrange and name/rename documents and folders.
• Increase or decrease magnification of the display and rotate a document.
• Copy and paste selected areas of documents into other documents.
• Move documents between disconnected ProPel-enabled PCs by exporting 

documents to a Package File and importing that Package File onto any 
other ProPel PC.

• Add any type of documents to ProPel, extending its usefulness as a document 
storage solution.

• Add notes to documents.
• Change the document sequence within any folder to follow the Chain of Title.
• Receive Branch Products, their supporting documents, and corresponding 

DoubleTime® data files via ProPel.
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Layout Of The Propel Screen
When ProPel starts, the screen shown below is displayed. The parts of the screen are 
briefly discussed here.

Note:  For the most part, buttons on the ProPel toolbar perform commonly used 

functions in the tree view, although some functions like Save Document  

Close Document    and Print      also perform functions on the 
document opened in the Acrobat Document Pane. Buttons on the Acrobat 
Toolbar only perform functions on the open document. The File > Print 

option in the ProPel menu or the Print button on the ProPel toolbar    are 
the only ways to print either entire documents or selected pages, whether the 
document is open in the Document Viewer or not. 
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ProPel Inbox Options
The settings for Tree View configuration set in Tools > Options > Inbox
determine how folders and documents arrive into the Inbox and whether 
additional text is added to the folder and document name display. These Inbox
Options are password-protected. Only a System Administrator can 
configure the Inbox settings for your entire office. All users should have the 
same Inbox configuration settings to maintain consistency in how folders are 
created and named when they arrive in the Inbox. All users on a network should 
be installed to share the same Inbox. The configuration settings included here 
are available only to the System Administrator.
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Note: You can specify how documents enter your Inbox, by defining two levels 
of folder display options for documents entering the Inbox. ProPel then 
creates your folder configuration by the choices made. 
• The first folder level is created directly under the Inbox folder in the Tree 
View Pane.
• The second folder level is optional and is created under the first folder level. 
The two options for creating folders are: ATIDS File Name/Number and 
Username. By selecting various combinations of these two options, you can 
organize your folders consistently in a way that is easily understood within the 
context of your office and how you do business.
Here’s an example of the Inbox Folder configuration with a first level folder 
and a second level folder with a document under the second level.

In the Propel Options dialog box, select the Inbox tab, and set your 
configuration according to the following five combinations:
Page 236 Web ATIDS Ver. 3.2



Lesson 7 - ProPel Additional Features
Configuration #1:  
This is the default configuration when ProPel is installed.

What You Do Comments
1. Select ATIDS File Name/

No. under 1st Level 
Folder.

You can also select Place HCPY Requests
under ATIDS File Name/No. folder, which 
means HCPY requests are displayed as files 
under the ATIDS File Name/No.

2. Select Username under 
2nd Level Folder.

3. Select any combination of 
options under Display 
Options for Search 
Results.

The default configuration for these options is 
Date and Time, but you can also choose to 
display the ATIDS File Name/No. and 
Username on these search results 
documents.

4. Click Apply and OK.

5. Example of Configuration 
#1
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Configuration #2:  
What You Do Comments

1. Select ATIDS File Name/
No. under 1st Level 
Folder.

You can also select Place HCPY Requests
under ATIDS File Name/No. folder, which 
means HCPY requests are displayed as files 
under the ATIDS File Name/No.

2. Select None under 2nd 
Level Folder.

3. Select any combination of 
options under Display 
Options for Search 
Results.

The default configuration for these options is 
Date and Time, but you can also choose to 
display the ATIDS File Name/No. and 
Username on these search results 
documents.

4. Click Apply and OK.

5. Example of Configuration 
#2

Configuration #3:  
What You Do Comments

1. Select Username under 
1st Level Folder.

You can also select Place HCPY Requests
under ATIDS File Name/No. folder, which 
means HCPY requests are displayed as files 
under the ATIDS File Name/No.

2. Select ATIDS File Name/
No. under 2nd Level 
Folder.

3. Select any combination of 
options under Display 
Options for Search 
Results.

The default configuration for these options is 
Date and Time, but you can also choose to 
display the ATIDS File Name/No. and 
Username on these search results 
documents.
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Configuration #4:  
What You Do Comments

1. Select Username under 
1st Level Folder.

You can also select Place HCPY Requests
under ATIDS File Name/No. folder, which 
means HCPY requests are displayed as files 
under the ATIDS File Name/No.

2. Select None under 2nd 
Level Folder.

3. Select any combination of 
options under Display 
Options for Search 
Results.

The default configuration for these options is 
Date and Time, but you can also choose to 
display the ATIDS File Name/No. and 
Username on these search results 
documents.

4. Click Apply and OK.

5. Example of Configuration 
#4

4. Click Apply and OK.

5. Example of Configuration 
#3

What You Do Comments
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Configuration #5:  
What You Do Comments

1. Select None under 1st 
Level Folder.

You can also select Place HCPY Requests
under ATIDS File Name/No. folder, which 
means HCPY requests are displayed as files 
under the ATIDS File Name/No.

2. Nothing can be selected
under 2nd Level Folder.

3. Select any combination of 
options under Display 
Options for Search 
Results.

The default configuration for these options is 
Date and Time, but you can also choose to 
display the ATIDS File Name/No. and 
Username on these search results 
documents.

4. Click Apply and OK.

5. Example of Configuration 
#5

Getting ATIDS Search Printouts & Document Orders Into ProPel
What You Do Comments

1.
 

 Click on the Get 
Documents button in the 
ProPel Tree View
toolbar

The ProPel Delivery Processor
automatically connects to The Fund and 
checks for any orders (hard copy or Branch 
Products) that were waiting for pickup, and 
delivers any waiting.
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Once the order has been successfully 
downloaded, the message Delivery 
completed successfully is displayed. A 
(+) is then displayed in front of the Inbox
indicating that a new order has been delivered. 
* Refresh F5: to update the Tree view Pane.

2. Click the (+) in front of the 
Inbox.

New orders arrive into the Inbox and are 
displayed as a folder name. The folder name is 
the same as your file created in ATIDS.Here 
we can see the new folder name ATIDS 
filename.

What You Do Comments
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3. Click the (+) in front of the 
folder ATIDS Filename.

The folder expands and displays the contents 
of the folder. Note: The method by which 
folders arrive into the Inbox and any 
additional text that is displayed next to ATIDS
search printout documents depends on how 
ProPel is configured, using Tools > 
Options > Inbox (See “ProPel Inbox 
Options” on page 235). Our example uses the 
default Configuration #1 with ATIDS File 
Name/No. for the First Level Folder and 
Username for the Second Level Folder.

4. Click the (+) in front of the 
folder FundNet User ID.

What You Do Comments
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Note: The second level sub-folder FundNet 
User ID contains the search results of each 
search that you performed in the ATIDS 
Search Menu (property search, and name 
searches). The other first level sub-folder 
ATIDS filename [FL-006-2011-017558]
(not yet expended) contains the related hard 
copy documents that were requested while in 
the ATIDS HCPY Menu.

5. Click the (+) in front of the 
first level sub-folder ATDS 
filename [FL-006-2011-
017558]

The folder expands and displays the contents 
of the folder (in this case, image files in the 
Acrobat Portable Document Format or PDF). 
Note: The configuration options you set in 
Tools > Options > Inbox determine 
whether an arriving hard copy (HCPY) folder 
is created as a sub-folder of a related folder or 
as a separate folder at the same level. Folder 
names for HCPY documents always show the 
Request ID information after the folder 
name.

What You Do Comments
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6. Double-click the Sub 
Condo document to open 
it into the Document Pane 
Viewer.

This document is the property search printout 
that you performed in ATIDS.

What You Do Comments
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7.
 

Click Decrease 
Magnification in the 
Acrobat Document Viewer
toolbar.

The default magnification for the Document 
Viewer is based on the percentage that allows 
one page to fit in the Document Viewer 
Pane. (It varies by the document.) 
Decreasing the magnification makes the 
document smaller in the Viewer. Note: When 
a document is open in the Acrobat Document 
Viewer, the Acrobat toolbar is activated. 
There is no need to click to select the 
document.

8.

 

Click Increase 
Magnification in the 
Acrobat Document Viewer
toolbar. 

This makes the document larger in the 
Viewer. Note: Use the scroll bar to view and 
display all pages of the property search.

What You Do Comments
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9. Double-click each of the 
search results documents to 
open them in the Viewer.

Note:  (1) As you open multiple documents, 
each subsequent document is opened on top of 
the previous one. (2) A maximum of 20 
documents can be open at one time.  

10. Close the current opened 
document by clicking the 

lower  
 

        in the top 
right corner of the window, 
or by clicking the Close 

Document button    
 

 
on the ProPel tree view 
toolbar.

The document closes from the Viewer, but any 
previously opened documents remain open. 
Note: To close all open documents from the 
Viewer simultaneously by clicking File > 
Close All.

11. Double-click the document 
TOC [FL-006-2011-
017558]

This is the print confirmation page for the 
hard copy (HCPY) order released in ATIDS. 
The Request ID number for the HCPY
order is added automatically by ProPel after 
TOC in the file name. Note: All hard copy 
documents ordered are listed on the TOC
(Table of Contents) document.

What You Do Comments
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12. Double-click each of the 
hard copy documents to 
open them into the Viewer, 
opening the plat PB 29 
196 last into the Viewer, so 
it is on top.

We'll use this document to demonstrate the 
Rotate tool.

What You Do Comments
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13. Click Tools > Rotate 
Clockwise to rotate the 
document to its upright 
position.

What You Do Comments
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Archiving Documents And Folders
To conserve hard drive space on your computer, you can archive documents and 
folders onto almost any kind of recording media (for example, a network server drive, 
a writeable CD, a Zip drive, or a removable disk drive, to name a few). 
To use the Archive feature of ProPel, first create an Archive folder which ProPel
stores on the external drive, but displays in the ProPel tree view. Then, select the 
documents or folders you want to archive, and drag them into the Archive folder. 
ProPel keeps track of the Archive folder location.

14. Close all open documents 
from the Viewer. 
(Remember, File > Close 
All)

Note: You will be asked if you want to save 
the changes you made to PB 29 196 before 
closing. Click Yes. The change you made was 
to rotate the document clockwise. Once you 
save this change, each time you open this Plat, 
it will be correctly oriented.

What You Do Comments
1. Select the Archive Root

folder (a cabinet symbol) at 
the bottom of the tree view.

2.   Click New Folder 
on the ProPel tree view 
toolbar (or select File > 
New > Folder in the 
menu).

The Browse for Folder dialog box is 
displayed.

What You Do Comments
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3. Select a location for the 
new folder (for example, a 
network server drive, a 
writeable CD, a Zip drive, 
or a removable disk drive), 
then click OK.

A folder named New Folder is created in the 
tree view (to represent the folder on the 
external media) where the documents will be 
stored. The folder name is selected 
(highlighted) to show you are in Edit mode. 
The folder name you type replaces the text, so 
make sure not to touch any other keys before 
you type the folder name.

What You Do Comments
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4.  Type a name for the new 
folder, then press the 
ENTER key. (In our 
example, the folder name is 
Atids Searches.)

This name is used only in the tree view to 
identify the folder for you.  ProPel uses its 
own folder naming convention to keep track 
of the folder on the external drive.

What You Do Comments
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Note: It is highly recommended that you move 
folders and documents out of the Inbox as 
soon as possible in order to maintain a 
functional and organized working 
environment. It is also important to regularly 
archive folders out of the ProPel tree view.

5. Click, hold, and drag the 
ATIDS filename [FL-
006-2011-017558] folder 
from the Inbox toward the 
Archive folder you just 
created until this 
destination folder is 
highlighted, then release 
your mouse button.

By holding, dragging, and releasing a folder, 
you have moved the entire folder (with its 
contents and sub-folders) into the Archive 
folder, out of your Inbox and off the Root of 
ProPel. Notice that as you begin to drag 
(move) the folder, ProPel shows a simulation 
of the folder to guide you. Make sure you do 
not release your mouse button until the 
destination folder is highlighted. Note: Once 
moved out of the Inbox, orders (folders and 
documents) cannot be moved back into the 
Inbox.

What You Do Comments
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Changing Document Sequence
ProPel allows you to change the sequence of documents in a folder. This is 
particularly useful in assisting you to place the documents in Chain of Title 
sequence, so you can print them in the order needed to send to your clients.

What You Do Comments
1. Click your right mouse 

button (right-click) on the 
folder in the Tree view 
Pane that you wish to re-
sequence. 

The right-click menu is displayed.

2. Click Document 
Sequence in the right-
click menu.

The Document Sequence dialog box is 
displayed.
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E-mailing Documents
ProPel provides an e-mail feature that enables you to send documents as e-mail 
attachments. You can send an individual document or an entire folder of documents. 
The document and folder attachments have the same names as they do in the ProPel
tree view.
ProPel's e-mail feature works with any MAPI e-mail client (for example, Microsoft 
Outlook and Outlook Express, Eudora, and Netscape, to name a few). Some on-line 
services like America On-Line (AOL) use a proprietary e-mail system that is not 
MAPI-compliant. ProPel e-mail does not work with these services. If you have a 
service that is not MAPI-compliant, you can use the ProPel export feature (File > 
Send to > File Folder) to send the document or folder to storage outside of ProPel, 
then manually attach it to an e-mail message.
Note: Most Internet Service Providers (ISP) have limits on the amount of data that can 

3. Click the document you 
want to re-sequence.

In our example, we'll move the Plat up to the 
second position.

4. Click the up (or down) 
arrow at the right of the 
dialog box until the 
document is in the desired 
position.

5. Click OK. The documents are now in the following 
order: Table of Contents, Plat, Affidavit, 
Mortgage, Agreement, Affidavit, Affidavit, 
Warranty Deed, and Federal Tax Lien.

What You Do Comments
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be attached to an e-mail message. This limit can vary from one ISP to another. 
Typically, the limit is approximately 2 megabytes (MB) per e-mail message, which is 
about 29 ProPel document pages. Check with your IT Administrator to verify the limit 
for your office ISP.

What You Do Comments
1. Click the document (or 

folder) you want to attach 
to an e-mail.

2. Click File > Send 
"[Document or Folder 
Name]" to > Mail 
Recipient.

This starts your e-mail program and attaches 
the selected document to a new e-mail. Note: 
If you select an entire folder to e-mail, all 
documents in the selected folder are displayed 
as PDF attachments in the e-mail window. 
From the e-mail window, you can remove any 
documents you do not want to send.

3. In our example, we have 
prepared an e-mail to send 
a copy of the Plat to the 
Seller's Attorney.
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Exporting Documents
ProPel offers a Send feature that allows you to export documents or folders to any 

other location on your system. This is especially useful when you don't have a MAPI-
compliant e-mail system, because you can export folders or documents to a destination 
outside of ProPel, then attach a document or an entire folder to an e-mail message for 

that location.
What You Do Comments

1. Click the document or 
folder you want to export.

2. Click File > Send 
"[Document or Folder 
Name]" to > File 
Folder.

This opens the Browse for Folder dialog 
box.

What You Do Comments
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What You Do Comments
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Sending Documents Or Folders To A Package File
ProPel provides a feature that allows you to copy documents into a Package File 
that can be used on ProPel-enabled PCs that are not connected to the network.  This is 
particularly useful if an attorney wants to review or examine documents outside the 
office.  The folders or documents can be sent from ProPel to a Package File that 
can then be copied to a CD, laptop, or other portable media to be used at home, or any 
location disconnected from your office network. 

3. Click the destination for 
the document or folder 
from the dialog box, then 
click OK.

The document is sent to the destination 
location. If the folder has sub-folders, the 
message below is displayed.

If you click Yes, all the documents in the 
selected folder and the documents in all sub-
folders are sent to the destination. If you click 
No, only the documents in the main folder are 
sent to the destination.

What You Do Comments
1. Click the document or 

folder in the Tree view
Pane that you want to send 
to a Package File.

2. Click File > Send 
"[Document or Folder 
Name]" to > Package 
File.

What You Do Comments
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3. Click the destination for 
the Package File in the 
dialog box, then click 
Save.

The Package File is saved to your selected 
location.

If the folder has sub-folders, the message 
below is displayed.

What You Do Comments
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Creating New Folders
ProPel allows you to create new folders in the Tree View Pane so you can organize 
your folders to facilitate your office business process. (See examples of ProPel
organization for two office environments on the following pages.)

If you click Yes, all the documents in the 
selected folder and the documents in all sub-
folders are sent to the destination. If you click 
No, only the documents in the main folder are 
sent to the destination.

What You Do Comments
1. Click the folder in the Tree 

View Pane under which 
you wish to create a new 
folder. 

You can create new folders under all folders 
(including Root and Archive) but you 
cannot create a new folder under Inbox, 
which is reserved exclusively for ATIDS
Search Results and Branch Products
sent to ProPel.

2. Click New Folder
on the ProPel tree view 
toolbar. 

This creates a temporary folder called New 
Folder in the location you specified. The 
folder name is in Edit mode to allow you to 
type the new name. What you type replaces 
the text, so make sure not to touch any other 
keys before you type the folder name.

What You Do Comments
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3. Type the name for the new 
folder, then press the 
ENTER key.

Note: The new folder has now been added at 
the bottom of the tree view under Archive. 
To sort it into alphabetical order above 

Archive, click Refresh    
 

        on the 
ProPel toolbar or press the F5 key. 

What You Do Comments
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Examples Of A Working Environment
Office A: 
Main Tree view Example

Note: Alpha letters in front of folders can be used to sort the working folders in 
a desired sequence.
Tree view Pane expanded to show folder detail.
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Office B:
Main Tree view Example:
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Tree view Pane expanded to show folder detail.
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Copying Folders And Documents
ProPel provides a Copy function that allows you to make a copy of a document or 
folder to store in another location in the Tree View Pane, while saving the original.

What You Do Comments
1. Click your right mouse 

button (Right-click) on the 
document or folder to be 
copied.

2. Click Copy in the right-
click menu.

This places a copy of the document or folder 
and its contents on the Clipboard, a 
temporary storage space in your computer 
memory.  Note:  Make sure you paste right 
after you copy, as the Clipboard only stores 
the item until the next Copy or Cut
operation.
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3. Right-click the folder into 
which you want to paste 
the newly-copied folder or 
document.

4. Click Paste in the right-
click menu.

This places the copy of the document or folder 
and its contents into the selected folder.

What You Do Comments
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Deleting Selected Pages Of A Document
The document from which you wish to delete selected pages must be open in the 
Acrobat Document Viewer Pane.

What You Do Comments
1. Double-click on the 

document in the Tree 
View Pane from which 
you wish to delete selected 
pages, to open it in the 
Acrobat Document Viewer.

Even though you have opened the document 
in the Acrobat Viewer, the Delete Pages
option is in the ProPel menu.

2. Click Tools > Delete 
Pages. 

This opens the Delete Pages dialog box.

3. Type the range of pages 
you wish to delete and 
click OK in the Delete 
Pages dialog box.

If you wish to delete only one page, type the 
same page number in both the From and To
boxes. Caution: There is no confirmation of 
your decision to delete pages, so make sure to 
verify your page deletion before clicking OK.
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Deleting Documents Or Folders From The Tree View
Documents or entire folders and their contents can be deleted from the Tree View.  It 
is recommended that you archive, rather than delete documents and folders after 
Examination; however, your office procedures determine your process.  To delete an 
entire document, it cannot be open in the Document Viewer Pane.

What You Do Comments
1. Right-click the document 

(or folder) in the Tree 
View Pane that you wish 
to delete.

2. Click Delete in the right-
click menu.

Note: If the document is open in the 
Document Viewer, an error message is 
displayed.
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Renaming A Folder Or Document
In ProPel, you can rename any document or folder. Remember that any data assigned 
to the original document or folder name (for example, type of search, search data like 
property name, date, and time on documents or FL# on folders) will be permanently 
lost when you rename the document or folder.

3. Click Yes to confirm the 
delete in the dialog box, 
once you have carefully 
verified that you want to 
delete the entire document 
(or folder).

Note: (1) The deleted document does not go 
into a recycle bin, from which it can be 
recovered if you make a mistake. It is 
permanently deleted from your system.If you 
accidentally delete a document or folder, you 
must contact the Branch to have them 
download the document order again. (2) Only 
hard copies less than two weeks old can be 
downloaded from the Branch again. 
Documents older than two weeks and ALL 
ATIDS search results cannot be resent.

What You Do Comments
1. Right-click the folder or 

document you wish to 
rename.

This displays the right-click menu.

2. Click Rename in the 
right-click menu.

The folder or document name is now in Edit
mode to allow you to type the new name. 
What you type replaces the text, so make sure 
not to touch any other keys before you type 
the folder name.

What You Do Comments
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3. Type the new name, which 
replaces the old name, then 
press the ENTER key.

What You Do Comments
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Scanning Documents into ProPel
You can scan any document into ProPel via your scanning device configured to 
connect to ProPel. You can either scan a document into a ProPel folder or append a 
document to an existing document in ProPel. Note: The instructions included here are 
for a scanner with Automatic Document Feeder (ADF).

What You Do Comments
1. To append a scanned 

document to an existing 
document, open the 
document to which you 
wish to append the newly-
scanned document (or click 
to select the document in 
the Tree View), or to scan 
a document into a ProPel
folder, click the folder into 
which you wish to scan a 
document.

Decide whether you wish to append to an 
existing document or to add a new document.

2. Place the document page(s) 
to be scanned in your 
scanner.

3. Click File > Scan. The ProPel Scan dialog box is displayed.
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4. Verify that your scanner 
device is displayed in the 
Scanner box.

5. Select from 100 to 300 dots 
per inch (DPI) for 
Resolution.

Note: If you change any settings, the Save 
As Default button is activated for you to 
save the new settings as the default.

6. Leave the rest of the 
default settings selected.

Note: (1) If there are any legal-sized pages in 
your documents to be scanned (even if there 
are also non-legal pages), set the Paper Size
to Legal. (2) If you selected a folder into 
which to scan the documents, the Open New 
PDF Document option is selected by 
default. (3) If you opened a document into the 
Document Pane, the Append to Current 
Document option is automatically selected.

7. Click Scan at the bottom 
of the dialog box.

Your scanner is activated, and the scan is 
completed. 

8. Type a name in the 
Document Name box for 
a new PDF document 
added to a folder.

No file name box is displayed for a document 
appended to another document.

9. Click OK to complete the 
scan.

The scanned document is stored in the 
selected folder or appended to the selected 
document.

What You Do Comments
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Adding Notes To Documents
ProPel provides extensive Notes functionality in the Acrobat Document Viewer 
Pane.  Our examples here will use the Sticky Note feature from the Acrobat Review 
and Comment button on the Document Pane toolbar. There are a number of other 
features that you may wish to explore on your own.

What You Do Comments
1. Open the PDF document to 

which you wish to add a 
Note.

2. Click Review and 
Comment on the Acrobat 
Document toolbar and 
click Add Sticky Note
(or use right-click menu).

This adds a small Note symbol that marks the 
text connected to a default Note to the 
document about halfway down the page.
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3. Drag both the marker and 
the Note box separately to 
the desired location for 
each on the page.

Notice that when you point to the Note box, a 
connector to the marker is displayed. This 
way, you can have multiple Notes marking 
different text on the page.

4. Type a Note regarding the 
document.

If you type more text than will fit in the Note 
window, the text scrolls automatically and a 
scroll bar is displayed on the right of the 
window. You can also resize the Note window 
by dragging the right or left lower corner 
when you point and see the double arrows.

5. Click Minimize in the 
upper right corner of the 
Notes window to close it.

The Note marker is still displayed in the 
document at the selected location. When you 
hover your pointer over the marker, the text of 
the Note is displayed in a tool tip. When you 
click the marker, the Note window is again 
displayed.

What You Do Comments
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6. Click Save on the ProPel 
tree view toolbar or click 
File > Save in the tree 
view menu.

Note: The ONLY way to save changes (like 
addition of Notes) to documents is with the 
ProPel tree view toolbar or menu. The Save 
function is not available in the Acrobat 
toolbar. The Note(s) is saved with the 
document, and a Note symbol is displayed in 
front of the document name in the tree view. 
To view the Note, simply open the document 
in the Document Viewer Pane.

7. Right-click on the 
document with the Note 
you just created, and select 
Page Display 
Preferences.

Before you can print Notes on documents in 
ProPel, you must configure Acrobat.

8. Select Commenting
under Categories.

What You Do Comments
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9. Select Print notes and 
popups under Viewing 
Comments, then click 
OK.

You can now print notes on documents.

10. Double -click the Note 
marker to maximize the 
Note.

What You Do Comments
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11. Click File > Print  in the 
ProPel menu or use the 
ProPel toolbar.

You can only print using the ProPel menu or 
toolbar.  

12. Click Documents and 
Markups under 
Comments and Forms.

13. Select other settings like 
Print Range and Copies
then click OK.

This selection prints out either all pages of the 
open document or individual pages selected 
under Print Range in this dialog box, along 
with any Notes added to the page or pages.

14. Click Comments
in the lower left corner of 
the Document Pane to 
display all the Notes in a 
summary window.

You cannot display both the individual Note 
and the Notes Summary at the same time.

What You Do Comments
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15. Click Print  in the ProPel 
toolbar and click 
Document and 
Markups under 
Comments and Forms.

16. Select other settings like 
Print Range and Copies
then click OK.

This prints the document or selected pages 
with all the Notes from the Notes Summary.

What You Do Comments
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Lesson 8 - Wrap Up
Lesson 8 - Wrap Up

Concept
In this lesson, you will practice the steps you have learned throughout the training 
session. These steps will guide you through your on-line search process. You will also 
learn how to properly sign-off the Web ATIDS system.

Objectives
• Review the ATIDS Search Checklist.
• Perform practice sessions.
• Logout of the Web ATIDS system

ATIDS Search Check List
What You Do Comments

1. Determine intended use of 
the title information

2. Sign on to the Web ATIDS 
System

3. Change County Verify or change the county currently 
assigned

4. Plat Information From Plat 
Name

Determine the source of plat for a subdivision/
condominium

5. View Sub/Condo Legals Determine the authorized legals for a 
subdivision/condo 

6. Document Posting 
Information

Search for a property document and the legal 
reference it is posted to

7. Policy Search-Platted Prior Fund policy search for Subdivisions/
Condominiums

8. Policy Search-Acreage Prior Fund policy search for Acreage/
Government lots Note: Document Posting 
Information can be used to verify the name 
and/or legal description shown on the policy

9. Order Branch Products Order a product from a branch

10. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to use 
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Practice Session 1 Transaction Information

11. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

12. Search Menu - 
Acreage/Govt Lot Search

Acreage/Govt Lot property search

13. General Index Commercial 
Name Variations

Find commercial name variations

14. Search Menu-Name Search Name search (personal and commercial, if 
any)

15. Search Menu-Tax Search Tax search (not available in all counties)

16. Search Menu-Policy 
Rating

Rate a policy for the promulgated amount and 
premium

17. Order Policies Order a copy of the prior Fund policy (include 
FAX number on all Order Policies orders)

18. Order Documents Menu Order hardcopies of documents

19. Logout Web ATIDS

Update/Post Closing Transactions
1. Sign on to the Web ATIDS 

System

2. Search Menu-Update 
Property Search

Property update

3. General Index Commercial 
Name Variations

Find commercial name variations

4. Search Menu - Name 
Search 

Name update

5. Logout Web ATIDS

LABEL TRANSACTION INFORMATION

County: Sarasota 
Legal Description: Lots 1-4, Cedars on Siesta Key, Plat Book 4, 

Page 60

What You Do Comments
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Use The Following Steps To Complete Session1:
What You Do Comments

1. Change County Change to Sarasota County

2. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to use 

3. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

4. General Index Commercial 
Name Variations

Check for commercial name variations

5. Search Menu-Name Search Name search (personal and commercial, if 
any)

6. Search Menu-Tax Search Tax search (not available in all counties)

7. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

8. Order Documents Menu Order hard copies of documents

9. Search Menu-Update 
Property Search

Property update

10. General Index Commercial 
Name Variations

Find commercial name variations

11. Search Menu - Name 
Search 

Update the name searches including 
commercial names

Practice Session 2 Transaction Information

Names: Elliott P. Rubinson
Pamela A. Keris-Rubinson
Horsefeathers

Search From Date: June 29, 1990
Folio#: 0127-06-0008
Transaction Amount: $4,000,000.00

LABEL TRANSACTION INFORMATION

County: Orange 

LABEL TRANSACTION INFORMATION
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Use The Following Steps To Complete Session 2:
What You Do Comments

1. Change County Change to Orange County

2. Document Posting 
Information

Obtain the posting reference

3. Policy Search-Platted Search for a prior policy. 

4. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to use 

5. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

6. Search Menu-Name Search Personal name search 

7. Search Menu-Tax Search Tax search (not available in all counties)

8. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

9. Order Documents Menu Order hard copies of documents

10. Order Policies Order a copy of the prior Fund policy (include 
FAX number on all Order Policies orders)

Practice Session 3 Transaction Information

Legal Description: Lot 1, Block B, Fountainbrook Townhouse 
Subdivision

Names: Jerry A. Machalek
Sally M. Olivier f/k/a Sally O. Machalek

Quit Claim Deed: OR 4172/562
Folio#: 23-22-29-2820-02010
Transaction Amount: $150,000.00

LABEL TRANSACTION INFORMATION

County: Lake 
Legal Description: Lots 6 & 7, Block 22, City of Clermont, Plat 

Book 8, Page 17S
Names: Howard D. Whiteman and Sarah B. Schaeffer

Roland Bondani

LABEL TRANSACTION INFORMATION
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Use The Following Steps To Complete Session3:
What You Do Comments

1. Change County Change to Lake County

2. Plat Information From Plat 
Name

Obtain the recording reference

3. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to  use 

4. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

5. Search Menu-Name Search Personal name search 

6. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

7. Order Documents Menu Order hard copies of documents

Practice Session 4 Transaction Information

LABEL TRANSACTION INFORMATION

County: Hillsborough 
Legal Description: NE ¼ of the NW ¼ of the NW ¼ less SR 

Right of Way & less W 25' for Road R/W Sec 
26, Township 29 S Range 21 East

Names: Berry Holding Group, Inc.
Warranty Deed: OR 10709/1518
Folio#: 086126-0000
Search From Date: April 4, 2001
Transaction Amount: 500,000.00

Use The Following Steps To Complete Session 4:

Search From Date: September 9, 2006
Transaction Amount: $300,000.00

What You Do Comments
1. Change County Change to Hillsborough County

LABEL TRANSACTION INFORMATION
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Practice Session 5 Transaction Information

LABEL TRANSACTION INFORMATION

County: Broward 
Legal Description: Lot 12, Block 1, Relco Estates, Plat Book 92, 

Page 7
Names: Marc A. Brands
Property Address: 9231 NW 32 Manor, Sunrise, FL 33351
Seller’s Address 8745 Sanibel Lane, Merritt Island, FL 32952
Folio#: 9120-11-0120
Transaction Amount: $115,000

Use The Following Steps To Complete Session 5:

2. Document Posting 
Information

Obtain the acreage codes

3. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to  use 

4. Search Menu - 
Acreage/Govt Lot Search

Acreage/Govt Lot property search

5. Search Menu-Name Search Commercial Name search and Commercial 
Name search Variations

6. Search Menu-Tax Search Tax search (not available in all counties)

7. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

8. Order Documents Menu Order hard copies of documents

What You Do Comments
1. Change County Change to Broward County

2. Policy Search-Platted Search for a prior policy. 

3. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to  use 

4. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

What You Do Comments
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Practice Session 6 Transaction Information

LABEL TRANSACTION INFORMATION

County: Orange 
Legal Description: Lot 60, Horseshoe Bend Section No. 1 

recorded in  Plat Book 13, Page 142
Names: Damion O. Tomlinson
Search From Date: September 26, 2005
Folio#: 01-22-28-3722-00600
Transaction Amount: $200,000.00

Use The Following Steps To Complete Session 6:

5. Search Menu-Name Search Personal name search 

6. Search Menu-Tax Search Tax search (not available in all counties)

7. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

8. Order Documents Menu Order hard copies of documents

9. Order Policies Order a copy of the prior Fund policy (include 
FAX number on all Order Policies orders)

What You Do Comments
1. Change County Change to Orange County

2. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to  use 

3. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

4. Search Menu-Name Search Personal name search 

5. Search Menu-Tax Search Tax search (not available in all counties)

6. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

7. Order Documents Menu Order hard copies of documents

What You Do Comments
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Practice Session 7 Transaction Information

LABEL TRANSACTION INFORMATION

County: Lee 
Legal Description: Lots 4 & 5, Block G, Paradise Shores
Names: Charles L. Ogden

Gertrude B. Ogden
William Fitzgerald

Search From Date: December 15, 1986
Transaction Amount: $175,000

Use The Following Steps To Complete Session 7:
What You Do Comments

1. Change County Change to Lee County

2. Plat Information From Plat 
Name

Obtain the recording reference

3. Search Menu - Add/
Change/Find File 

Add an ATIDS file (Refer to the Bill Code 
Brochure for the proper bill code to  use 

4. Search Menu - 
Subdivision/Condo Search

Subdivision/Condo property search

5. Search Menu-Name Search Personal name search 

6. Search Menu-Policy 
Rating

Rate the policy for the promulgated amount 
and premium

7. Order Documents Menu Order hard copies of documents

8. Search Menu-Update 
Property Search

Property update

9. Search Menu - Name 
Search 

Update the name searches 

What You Do Comments
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Logout
What You Do Comments

1. From the Main Menu or 
Search Menu, click on 
the      Logout hyper-link

After doing so, the Logout screen appears.
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The Smart Title Solution
For more than 30 years, Fund members have relied on The Fund’s Automated Title 
Information Data System (ATIDS) to help facilitate the title search and examination 
process. ATIDS is the premier source of geographically posted, online title information 
in Florida.  Updated daily, this vast data repository provides the most current, complete 
and reliable title information available.  

Comprehensive Online Access to information.

• Access more than 175 million Florida real property records.

• Instantly view images of recorded documents in real time. 

• Encompasses nearly 40 of the state’s most active counties. 

• Provides a minimum 20-year judgment search that will fi nd judgments, federal 
 tax liens, divorces, and probates.

• Index to title policies issued on The Fund since its inception in 1948. 

• Extensive hours of availability. 

• Documents and searches can be saved electronically. 

• Multiple users may access ATIDS simultaneously at no additional charge. 
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Proper Use of ATIDS Files
What are your responsibilities for the proper use of ATIDS Files?

Your ATIDS contract requires that you establish a separate ATIDS fi le for each closing transaction 
or litigation action.  If you perform multiple unrelated searches or closings within one fi le, you will 
be liable for additional fi le charges. As an ATIDS Customer, you are ultimately responsible for 
making sure that ATIDS policies and contract terms are followed by the ATIDS users in your offi ce.  

Attorneys’ Title Fund Services, LLC (ATFS) performs periodic reviews of ATIDS accounts to ensure 
that ATIDS fi les are being used properly.  If our review reveals that you are not using ATIDS fi les in 
accordance with our policies and contract terms, you will be assessed additional charges, which 
must be paid in order to maintain your access to the system.

For information on the correct bill codes used to establish fi les, refer to the ATIDS Quick Reference 
Guide in your ATIDS Training Material.  Prices are listed on this guide as well as in the ATIDS 
Contract.  

Intent to Write an Old Republic National Title Insurance Company (ORNTIC) policy 
processed through Attorneys’ Title Fund Services, LLC:  If you establish an ATIDS fi le using 
a bill code that allows you to answer Y for yes to the policy intent questions, then you must remit 
an ORNTIC policy. 

Closing Bill Codes
One Closing Transaction or Litigation Action Per File:  A transaction consists of the searches 
performed for one real estate transaction (closing) or one litigation action.  Regardless of whether 
or not a closing is taking place, each search for a single reason must have its own fi le.  If you 
perform multiple unrelated searches or closings within one fi le, you will be liable for additional 
ATIDS fi le charges.  For example, if you represent a developer who will be selling individual lots 
to separate buyers, you must establish a new fi le for each property transfer.

Non-Closing Bill Codes
Usage-Based Files:  A usage-based fi le is not to be used for issuance of a title insurance policy.  
A charge is incurred for each legal or name search, every time that legal description or name is 
searched.  ATFS assumes no liability for these types of ATIDS fi les. 

Training:  ATFS offers ATIDS training at no charge.  The ATIDS I Basic Training Seminar is 
required of all new users of ATIDS.  It introduces novice users to the ATID System transactions 
and requirements for use.  Employees that have used ATIDS in the past, but need a refresher, 
may also benefi t from the ATIDS I Basic Training Seminar.  

Who to contact:  
To schedule ATIDS training, contact ATFS’s Education Registrar at (888) 407-7775 or email 
educationregistrar@thefund.com.  Arranging training for new employees is the responsibility of 
the member or customer.

If you have any questions about the proper way to establish fi les, please contact ATFS Help Desk 
at 1.800.421.9378.
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Source of Reference Codes
There are three tables in this section. Table 1 lists all source of plat reference codes. Table 2 
lists the source of reference codes for documents and court cases alphabetically by source of 
reference.  Table 3 lists the source or reference codes alphabetically by code.

1. Plat Codes

The UN code indicates either an unrecorded plat or one that may not have been recorded in 
the usual place (for example, a plat attached to a deed).

Condominiums: Refer to the Condominium Plat Book or the Condominium Declaration code, 
depending on the reference given in the legal description.

Plat Source      Code

Chancery Order      CO

Clerk Number      CN

Commissioners’ Minute Book   MN

Condominium Declaration    OR

Condominium Plat Book    CB

Deed Book       DB

Minor Plat Book (Alachua & Hillsborough) MP

Miscellaneous Book     MS

Mortgage Book      MB

Oil & Gas       OG

Planned Unit Development (PUD) Book  PU

Plat Book       PB

Print Book       NT

Quit Claim Book      QC

Road Plat Book      RP

Survey Book      SB

Transcript Book      TB

Unrecorded Plat      UN
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Source of Reference                            Code

A

Assignment & Satisfaction of Judgment Book        AS

Assignment of Judgment Book           AJ

Assignment of Mortgage Book           AM

C

Chancery Action – Civil Court           CO

Chancery Action – Court of Record          CR

Civil Action – Circuit Court            CA

Clerk’s Number              CN

Code Enforcement             CE

Commissioners’ Minute Book           MN

Condominium Book             CB

Court of Appeal              AC

D

Deed Book              D

Drainage District              DD

F

Federal – Bankruptcy             FB

Federal – Civil Action             FC

Federal Criminal              FR

Federal Tax Lien Book             FL

Final Judgment Book             JF

Foreign Judgment Book            FJ

G

Guardianship              GS

H

Hospital Lien Book             HL

I

Incompetency Book             CI

2. Document/Court Case Codes by Document
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Source of Reference                            Code

Incorporation Book             I

J

Judgment Lien Book             JL

L

Law – Circuit Court             LA

Lien Book               L

Lis Pendens Book             LP

Lunacy               CI

M

Marriage License Book            ML

Minutes – Circuit Court            CM

Miscellaneous Book             MS

Mortgage Book              M

N

Notice of Commencement Book           NC

O

Offi cial Records Book             OR

Oil and Gas              OG

Oil Book               OB

Order & Judgment – Circuit            OJ

Order & Judgment – Court of Record          JC

Ordinance Number             ON

P

Patent               PT

Planned Unit Development Book           PU

Plat Book               PB

Probate               CP

Probate/Guardianship Book            PG

Q

Quit Claim Book                  QC
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Source of Reference                            Code

R

Resolution Number             RN

Road Plat Book              RP

S

Satisfaction of Judgment Book           SJ

Satisfaction of Mortgage Book           SM

Small Claims Court             SC

Supreme Court              SU

Survey Book              SB

T

Tax Certifi cate Book             TX

Tax Certifi cate Number            CF

Tax Deed County             TC

Tax Deed State              TS

Title Abstract              TA

Title Opinion              TO

U

Uniform Commercial Code            UC

Unknown               UK

Unrecorded Book             UN

W

Will Book               WB
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3. Document/Court Case Codes by Code

Code  Source of Reference                            

A

AC Court of Appeal

AJ Assignment of Judgment Book

AM Assignment of Mortgage Book

AS Assignment & Satisfaction of Judgment Book

C

CA Civil Action – Circuit Court

CB Condominium Book

CE Code Enforcement

CF Tax Certifi cate Number

CI Incompetency Book Lunacy

CM Minutes – Circuit Court

CN Clerk’s Number

CO Chancery Action – Civil Court

CP Probate

CR Chancery Action – Court of Record

D

D Deed Book

DD Drainage District

F

FB Federal – Bankruptcy

FC Federal – Civil Action

FJ Foreign Judgment Book

FL Federal Tax Lien Book

FR Federal Criminal

G

GS Guardianship

H

HL Hospital Lien Book
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I

I Incorporation Book

J

JC Order & Judgment – Court of Record

JF Final Judgment Book

JL Judgment Lien Book

L

L Lien Book

LA Law – Circuit Court

LP Lis Pendens Book

M

M Mortgage Book

ML Marriage License Book

MN Commissioners’ Minute Book

MS Miscellaneous Book

N

NC Notice of Commencement

O

OB Oil Book

OG Oil and Gas

OJ Order & Judgment – Circuit

ON Ordinance Number

OR Offi cial Records Book

P

PB Plat Book

PG Probate/Guardianship Book

PT Patent

PU Planned Unit Development Book

Q

QC Quit Claim Book

Code  Source of Reference                            
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R

RN Resolution Number

RP Road Plat Book

S

SB Survey Book

SC Small Claims Court

SJ Satisfaction of Judgment Book

SM Satisfaction of Mortgage Book

SU Supreme Court

T

TA Title Abstract

TC Tax Deed County

TO Title Opinion

TS Tax Deed State

TX Tax Certifi cate Book

U

UC Uniform Commercial Code Book

UK Unknown

UN Unrecorded Book

W

WB Will Book

Code  Source of Reference                            

9
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 AA    Assumption Agreement, Joinder  

 AC     Appointment of Agent  

 AD     Agreement for Deed Assignment for Agreement for Deed Contract for   

  Deed Sale or Purchase  

 ADD     Administrator Deed  

 ADP    Adoption  

 AFF     Affi davit Clerk’s Certifi cation  

 AGR     Agreement Certifi cate of Limited Partnership Dissolution of Partnership 
  Non Use Commitment Property Settlement Agreement  

 AJ    Assignment of Judgment  

 AJD     Amended or Modifi ed Judgment  

 AL     Assignment of Lien  

 ALS     Assignment of Lease, Rentals  

 AM    Assignment of Mortgage Assignment of Deed of Trust  

 AML    Amended Lien  

 ANE    Agreement Not to Encumber  

 ANL     Annulment  

 ANR     Agreement Not to Receive (Accept) Future Advances  

 ASN     Assignment, Contract Assignment 

 B 

 BC     Birth Certifi cate  

 BNK    Bankruptcy/Receivership Discharge of Bankruptcy/Receivership 
  Suggestion of Bankruptcy  

 BOS     Bill of Sale  

 C

 CA     Certifi cate of Approval  

 CAV    Caveat  

 CHA     Chattel Mortgage  

Code         Type of Instrument

A
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 CHR     Charter  

 CIT       Certifi cate of Additional Intangible Tax  

 CJD       Cost Judgment Attorney’s Fees  

 CL       Claim of Lien, Mechanics (Labor, Materials & Service) Contest of Lien 
    Waiver of Lien (Mechanics)  

 COM     Certifi cate of Merger  

 CON     Change of Name  

 COO     Certifi cate of Organization  

 COT      Contract Assignment of Contract  

 CPL      Complaint  

 CS       Certifi cate of Sale  

 CT      Certifi cate of Title  

 CTF       Certifi cate  

 D      Deed  

 DC       Death Certifi cate  

 DCL       Disclaimer Real Property Waiver  

 DEC       Declaration  

 DIS       Dismissal/Discharge (Order of)  

 DIV       Divorce  

 DKT       Docket  

 DM       Deed and Mortgage  

 DOC     Declaration of Condominium

  

 E       Easement (or Grant of)  

 ECL       Estate Tax Closing Letter  

 EMD     Eminent Domain (Order of Taking)  

 ETL       Estate Tax Lien, Federal or State  

 EX       Execution  

D

E
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EXD     Executor’s Deed  

FA     Future Advance (includes Limitation of, Cancellation of, and Waiver of)   

  Notifi cation of Additional Advance Assignment, Receipt of Advance  

 FDS     Free Dealership  

 FN     Fictitious Name, Affi davit of  

 FSD     Fee Simple Deed  

 FTL    Notice of or Refi le of Federal Tax Lien Income Tax Lien  

 GD     Guardian’s Deed  

 GRD   Guardianship Curator Custodian

  

 HQ    Red Alert – Call Headquarters  

 IBK    Involuntary Bankruptcy  

 ICM    Incompetency  

 INC    Incorporation, Articles of Dissolution of Corporation  

 ITX     Intangible Tax  

 JDG     Final Decree Judgment Final Judgment of Foreclosure  

 JND     Joinder  

 JUN     Junk  

 LN     Lien (Hospital, Welfare, or Assessment, etc.) Lien for Worker’s Compensation  

 LP     Lis Pendens  

 LS     Lease Cancellation of Lease  

 LVY     Levy Write of Attachment Execution  

 M     Mortgage Deed of Trust Pledge  

 MAN     Mandate  

G

H

J

L

I

M

F
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 MC     Marriage Certifi cate  

 MCR   Mortgage Certifi cate of Release  

 MIS     Miscellaneous  

 MMA   Mortgage Modifi cation Agreement Adjustable Rate Ride Extension Agreement  

 MOD   Modifi cation Agreement  

 NA     Notice of Appeal  

 NC     Notice of Commencement  

 NOT     Notice  

 NR     Name Restoration  

 NTC     Nontaxable Certifi cate and Receipt of Estimated Tax  

 NTL     Notice of Tax Lien (State, Local) Florida Industrial Commission Lien Intangible  

  Tax Lien  

 O     Order  

 OOT     Order of Taking Condemnation Eminent Domain  

 OPT     Option  

 ORD   Ordinance 

 PA     Power of Attorney  

 PAL     Partial Assignment of Lease (special Land lease: Escambia & Santa Rosa counties)  

 PAT     Patent  

 PDC     Public Defender’s Claim  

 PET     Petition  

 PFB     Performance Bond (Payments)  

 PLT     Plat Survey  

 PR     Partial Release  

 PRD     Personal Representative’s Deed  

 PRJ    Partial Release of Judgment  

 PRL     Partial Release of Lien  

N

O

P

13
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Q

R

 PRM   Partial Release of Mortgage  

 PRO   Probate (may be further defi ned in remarks) This code covers a wide variety of   

  Probate documents fi led in the Offi cial Records, such as: Administration 

  Designation of Homestead Federal Estate Tax Receipt Final Distribution 

  Inheritance Estate Tax Letters Testamentary/Administration Proof of Will 

  Receipt of Estate Tax Summary Administration Will, Admittance of 

 

 QCD   Quit Claim Deed  

 R     Restrictions/Covenants Release of Restrictions  

 RAC     Revocation of Appointment of Agent  

 RE     Release of Easement  

 REL     Release, Cancellation  

 RET     Release or Waiver of Estate Tax, Federal or State  

 RFT     Release or Satisfaction of Federal Tax Lien  

 RIC     Restoration of Incompetency Return to Competency  

 RL     Release or Satisfaction of Lien (Mechanics Only)  

 RNA     Removal of Non-Age Disability  

 RNE     Release or Satisfaction of Agreement Not to Encumber  

 RPA     Revocation of Power of Attorney  

 RSN     Resolution  

 RSV     Reservations  

 SA     Security Agreement  

 SAL     Assignment of Special Land lease (Escambia & Santa Rosa counties)  

 SAT     Satisfaction  

 SD     Sheriff’s Deed  

 SEP     Separation Agreement  

 SJ     Satisfaction Final Decree Satisfaction of Intangible Tax Satisfaction of Judgment   
  Satisfaction of Tax Executions  

S
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 SL     Satisfaction or Release of Lien Satisfaction or Release of Tax Lien (State, Local)  

 SLL     Special Land lease (Escambia & Santa Rosa counties)  

 SM     Satisfaction, Cancellation, or Release of Mortgage Release Deed (Trust)  

 SPA     Subordination of Pledge Agreement  

 STK     Stock Certifi cate  

 SUB     Subordination Agreement  

 SUP     Support  

 SWD   Special Warranty Deed 

 

 TAG     Trust Agreement Cancel Trust Agreement Revocation of Trust Agreement  

 TAP     Trustee Appointment Trust Under Will Discharge of Trustee  

 TR     Trustee Resignation  

 TRD     Trustee’s Deed  

 TRL     Transfer of Lien  

 TW     Tax Warrant State Warrant  

 TXD     Tax Deed  

 UCC   Uniform Commercial Code Financing Statement Security Agreement  

 UCO   Uniform Commercial Code  

 USA     Patriot’s Act Alert  

 UT     Unity of Title 

 

 VBN     Voluntary Bankruptcy  

 VER     Verdict  

 VLN     Violation  

 VML     Voluntary Mortgage Lien  

 WD     Warranty Deed  

 WDM   Warranty Deed and Mortgage  

 WIL     Will Construction of Will and Codicil  

T

U

V

W
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                                         ATID    Y040    EXS     ****   ATTORNEYS’ TITLE FUND SERVICES, LLC.    ****                    05/31/2011
                                                                                                                          09:30:19

                                                         FUND  BRANCH  INFORMATION:  CERTIFIED THROUGH   05/12/2011  AT  1100  PM
          CERTIFIED  THROUGH  BOOK  24522  PAGE  44
          CERTIFIED  FROM  12/14/1977

                FILE NUMBER:   TOI  CODE  TABLES
                DESCRIPTION:   TOI  CODE  BOOK

    
                         ATID               Y040   EXS            ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.       ****            05/31/2011
                                           FOR COUNTY OF PALM BEACH                09:30
                        SP-     PB       BK-               25      PG-        17            FILE/ORDER   REF:     TOI     CODE     TABLES
     SEARCH       FROM-   09161993     THRU-       05122011                 ID-
                                             --L1--            --L2--     --L3--           --L1--         --L2-- -   -L3--         --L1--            --L2--           --L3--

->                       3                    7
->
->

     PLAT NAME:
          BOCA WOODS (CONTAINS LTS IN BLKS 1-17)

DATE OF PLAT- 01/22/1957                AUTHORIZED LEVELS- LB / /
PLAT CERTIFIED - ALL POSTINGS CONFORM TO AUTHORIZED LEGALS.
FUND BRANCH CERTIFIED THROUGH 05/12/2011 AT 11:00 PM

********* RETRO DATA CERTIFIED *********

10 instruments found for search arguments

ATID                                              ****     ATTORNEYS’ TITLE FUND SERVICES, LLC. ****   PAGE  0001  OF  0010
DOF:  01032011               PR:   OR 24290 113              SR:   CN 2011 0001113            DOI: 01011900
TOI:   NC        DESC:                     MIN: - -
1ST PARTY:  JAMES    HANSEN  A/K/A  JAMES D HANSEN 2735 NE 4TH DR BOCA RATON FL 33431
2ND PARTY:

                               AMOUNT:         NAME:             TYPE:
                         REFERENCE:
                                   LEGAL:     BLK    7    LT    3    BOCA  WOODS     (PB 25/17)
    COMMENTS:    C-$$SUPERIOR  FENCE & RAIL$#520   NW   1ST ST#DEERFIELD   BCH   FL 33441#@L-$
        $NONE$

1st pg-SEARCHD                       3/            7/                 PB            25 /                                17 09/16/1993-05/12/2011

ATID                                             ****     ATTORNEYS’ TITLE FUND SERVICES, LLC. ****    PAGE  0002  OF  0010
DOF:  06222004               PR:   OR   17144                1654                     SR:    CN  2004    0358589       DOI: 05122004
TOI:   SM         DESC:                                                                                                          MIN:                  -                         -
1ST PARTY:     BK   AMER   N  A  SUCC  TO  B   A  MTG   L  L  C   SUCC   TO   NATIONSBANC   MTG   CORP
2ND PARTY:   JAMES  D  HANSEN    SHERRY  S  HANSEN

                             AMOUNT:                                             NAME:              TYPE:
                         REFERENCE:   OR   7889/170
                                   LEGAL:   NONE

COMMENTS:
                                     SEARCHD                       3/            7/                 PB            25 /                                17 09/16/1993-05/12/2011

ATID                                              ****     ATTORNEYS’ TITLE FUND SERVICES, LLC. ****   PAGE  0003  OF  0010
DOF:  03062003               PR:   OR  14886                    342                    SR:   CN 2003   0127285          DOI:    03042003
TOI:   AFF       DESC:                                                                                                           MIN:                  -                         -
1ST PARTY:    FRANK   NOWICKI
2ND PARTY:

                             AMOUNT:                                             NAME:                                                                            TYPE:
                         REFERENCE:
                                  LEGAL:  BOCA  WOODS   PB   25/17
                         COMMENTS:  *JNT
                SEARCHD                       3/            7/                PB             25 /                               17 09/16/1993-05/12/2011

ATID                                             ****      ATTORNEYS’ TITLE FUND SERVICES, LLC. ****  PAGE  0004  OF  0010
DOF:  11241999               PR:   OR    11472               1681                     SR:    CN   1999   0467660       DOI: 01011900
TOI:   NC         DESC:                                                                                                           MIN:                -                        -
1ST PARTY:    JIM   HANSEN   2735    NE   4TH   DR    BOCA   RATON   FL
2ND PARTY:

                            AMOUNT:                                              NAME:                                                                            TYPE:
                         REFERENCE:
                                  LEGAL:   LT    3       BLK    7    BOCA   WOODS
                         COMMENTS:    C-$$GUSTAFSON   IND   INC$#PO   BOX    832#BOYNTON   BEACH   FL    33425#L-$$NONE$ @
                                 POST PB 25/17
                                     SEARCHD                      3/             7/                PB             25 /                              17 09/16/1993-05/12/2011

Printout continued on next page...

An example of a property search printout is shown below:
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                                         ATID                                             ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0005  OF  0010
DOF:    10241995               PR:     OR   8970              1301                     SR:      CN   1995      0341976  DOI:  07151995
TOI:    AM       DESC:                                                                                                            MIN:               -                         -
1ST PARTY:     SOURCE   1   MTG   SVC   CORP   F/K/A    FIREMANS   FUND   MTG   CORP  

                    2ND PARTY:   NATIONSBANC   MTG   CORP
                                             AMOUNT:                                      NAME:                                                                                       TYPE:
                                         REFERENCE:  OR   7889/170
                                                   LEGAL:   NONE
                                         COMMENTS:
                                                     SEARCHD                       3/            7/                  PB             25 /                               17 09/16/1993-05/12/2011

ATID                                            ****     ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****  PAGE  0006  OF  0010
DOF:  06011994                   PR:   OR   8285 1278                                  SR:       CN   1994   0191651    DOI:  05171994
TOI:   AM        DESC:                                                                                                          MIN:                -                          -
1ST PARTY:    FORTUNE   BK

                                         2ND PARTY:   SOURCE   1   MTG   SVC   CORP
                                             AMOUNT:                                      NAME:                                                                                       TYPE:
                                         REFERENCE:   OR   7889/170
                                                   LEGAL:   NONE
                                         COMMENTS:
                                                     SEARCHD                       3/             7/                 PB             25 /                               17 09/16/1993-05/12/2011

                    ATID                                            ****     ATTORNEYS’ TITLE FUND SERVICES, LLC.   ****  PAGE  0007  OF  0010
                                          DOF:  09161993                  PR:   OR   7889 177                                    SR:       CN   1993   0296269    DOI:  01011900

TOI:    AFF       DESC:   IDENTITY                                                                                  MIN:                 -                         -
1ST PARTY:     JAMES D HANSEN
2ND PARTY:

                        AMOUNT:                                     NAME:                                                                                        TYPE:
                                         REFERENCE:
                                                    LEGAL:  LT   3   BLK   7   PB     25/17
                                         COMMENTS:
                                                     SEARCHD                       3/             7/                 PB             25 /                               17 09/16/1993-05/12/2011

                     ATID                                            ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0008  OF  0010
                                          DOF:  09161993                   PR:  OR   7889 176                                    SR:       CN   1993   0296268    DOI:   09151993
                                          TOI:   AM        DESC:                                                                                                         MIN:                 -                          -

1ST PARTY:     ADDISON   MTG   GROUP   INC
2ND PARTY:   FORTUNE   BK

                                             AMOUNT:                                      NAME:                                                                                       TYPE:
                                         REFERENCE:  OR   7889/170
                                                   LEGAL:   LT   3   BLK   7   PB     25/17
                                         COMMENTS:
                                                    SEARCHD                        3/            7/                 PB             25 /                               17 09/16/1993-05/12/2011

ATID                                             ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0009  OF  0010
DOF:   09161993                  PR:   OR   7889              170                       SR:       CN 1993   0296267    DOI:   09151993
TOI:    M           DESC:                                                                                                         MIN:                 -                          -
1ST PARTY:      JAMES   D   HANSEN   SHERRY S   HANSEN
2ND PARTY:   ADDISON  MTG  GROUP   INC  2500   N   MILITARY   TRAIL   480  BOCA  RATON  FL   33431
    AMOUNT:   60000.00                   NAME:   ADDISON   MTG   GROUP                                  TYPE: CONV

   REFERENCE:
             LEGAL:   LT   3   BLK   7   PB    25/17
   COMMENTS:
              SEARCHD                       3/            7/                  PB             25 /                               17 09/16/1993-05/12/2011

ATID                                             ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0010  OF  0010
DOF:   09161993                  PR:   OR   7889              169                       SR:       CN 1993   0296266     DOI:   09151993
TOI:    WD       DESC:                                                                                                         MIN:                   -                          -
1ST PARTY:     LINDLEY   J   SHIPLEY   MARGARET   B   SHIPLEY   H/W
2ND PARTY:   JAMES  D  HANSEN  SHERRY  S  HANSEN  H/W  2735  NE  4TH  DR  BOCA  RATON FL 33431
   AMOUNT:    896.00                       NAME:   KEHRES,   GRANT   W   ATTY                           TYPE:

   REFERENCE:  TN   06-43-47-17-04-007-0030
          LEGAL:   LT   3   BLK   7   PB     25/17

   COMMENTS:

                                         Lst   pg-SEARCHD                     3/            7/                 PB             25 /                                17 09/16/1993-05/12/2011

                                                  ****************************** SEARCH COMPLETE *****************************

Printout continues from previous page...
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1. How to Read a Printout

DOF - Date of Filing. Month, day, and year the document was fi led in the public records. 

PR - Primary Reference. Type of book, book number, and page number where the document is recorded 
at the courthouse. In Sarasota County, for documents with a date of fi ling on or after 5/18/98, this is the 
Offi cial Records Instrument number. 

SR - Secondary Reference. Clerk’s fi le number, for documents recorded in the Offi cial Records. 

DOI - Date of Instrument. Month, day, and year the document was executed. If DOl is later than DOF, or 
was unavailable or illegible when the document was entered into ATIDS, this fi eld displays 01011900. 

TOI - Type of Instrument. Type of instrument code that correspond as closely as possible to the actual 
type of document. 

DESC - Description. Clarifi es information in the TOI fi eld, or contains additional information about a 
document. 

MIN - Mortgage Identifi cation Number.  A unique number for identifying loans.  The MIN comes from 
either the Assignment of Mortgage Instruments or the Mortgage Instruments.

1st Party - Usually the party initiating and signing the document; includes marital status if available. Ex-
ample: Seller or grantor on a deed. 

2nd Party - Recipient of the action created by the document; includes marital status and type of estate, if 
available. Example: Buyer or grantee on a deed, or mortgagee on a mortgage. 

AMOUNT - Dollar amount.

NAME - Displays scrivener name, collateral name (on UCO documents), or other names. 

TYPE - Mortgage type codes or UCC/UCO fi nancing statement type codes. 

REFERENCE - Recording reference(s). If document is part of a case, the case number is referenced. 

LEGAL - Legal description, including subdivision name if applicable. If the legal description is too long 
for the fi eld, (INC) at the end indicates the description is incomplete. 

COMMENTS – Special or descriptive information.

ATID                                             ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0010  OF  0010
DOF:   09161993                  PR:   OR   7889              169                         SR:      CN 1993   0296266     DOI:   09151993
TOI:     WD     DESC:                                                                                                         MIN:                   -                          -
1ST PARTY:   LINDLEY   J   SHIPLEY   MARGARET   B   SHIPLEY   H/W
2ND PARTY:  JAMES  D  HANSEN  SHERRY  S  HANSEN  H/W  2735  NE  4TH  DR  BOCA  RATON FL 33431
   AMOUNT:   896.00                       NAME:   KEHRES,   GRANT   W   ATTY                          TYPE:

 REFERENCE:   TN   06-43-47-17-04-007-0030
        LEGAL:   LT   3   BLK   7   PB   25/17

COMMENTS:

                                       Lst   pg-SEARCHD                      3/            7/                 PB              25 /                              17 09/16/1993-05/12/2011

ATID                                             ****    ATTORNEYS’ TITLE FUND SERVICES, LLC.  ****   PAGE  0010  OF  0010
DOF:   09161993                  PR:  OR   7889              169                         SR:     CN 1993   0296266     DOI:   09151993
TOI:     WD     DESC:                                                                                                         MIN:                   -                          -
1ST PARTY:   LINDLEY   J   SHIPLEY   MARGARET   B   SHIPLEY   H/W
2ND PARTY:  JAMES  D  HANSEN  SHERRY  S  HANSEN  H/W  2735  NE  4TH  DR  BOCA  RATON FL 33431
   AMOUNT:   896.00                       NAME:   KEHRES,   GRANT   W   ATTY                          TYPE:

 REFERENCE:   TN   06-43-47-17-04-007-0030
        LEGAL:   LT   3   BLK   7   PB   25/17

COMMENTS:

           Lst   pg-SEARCHD                      3/            7/                 PB              25 /                              17 09/16/1993-05/12/2011
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Document Posting Info (LKUP) Tables
There are fi ve tables in this section. Table 1 lists the type of estate abbreviations that may 
be displayed in the Second Party box in the Document Posting Information function (LKUP). 
Table 2 lists other reference abbreviations. Table 3 lists reference information that may 
appear for specifi c documents. Table 4 lists mortgage type codes. Table 5 lists UCC/UCO 
fi nancing statement type codes.

1.  Abbreviations for Types of Estates

Abbreviation        Estate Type

EST BY ENTIR   Estate by the Entirety 

ENTIR     Entirety, Entireties 

J/T      Joint Tenants with Right of Survivorship 
     Joint Tenants with Right of Survivorship and not 
     Tenants in Common 
     Joint Tenants with Survivorship

 LIFE EST     Life Estate 

TEN BY ENTIR    Tenants by Entirety 

T/I/C      Tenants in Common 

UNDIV INT           Undivided Interest 

UNDIV __% INT    Undivided __% Interest 

W/R/S     With Right of Survivorship 

Abbreviation                    Reference

A/I/F             Attorney in Fact 

A/K/A              Also Known As Sometimes Known As 

D/B/A                   Doing Business As 

F/B/O             For Benefi t Of 

F/K/A               Formerly Known As 

K/A              Known As 

N/K/A              Now Known As 

PERSONAL REP EST        Personal Representative of Estate 

T/A             Trading As 

T/U/W             Trust Under Will 

U/A             Under Agreement 

U/T             Under Declaration of Trust, Under Trust 

U/T MMDDYY (DATE)        Under Declarations of Trust Dated Under Trust Dated

2.  Abbreviations for Other References
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Document Type  Reference  Amount  Name  Type

Assignment    Original Reference –   –  –

Assumption/Modifi cation Original Reference –   –  –

Claim of Lien    –   Lien Amount  –  –

Court Case    Case Number  –   –  –

Deed     –   State Stamps   Scrivener –

Intangible Tax   Original Reference –   –  –

Mortgage    –   Mortgage  Scrivener Mortgage 
       Amount     Type

Notice of Commencement –   –   Owner  –

Ordinance   Ordinance Number –   –  –

Patent    Patent Number –   –  –

Release   Original Reference –   –  –

Satisfaction   Original Reference –   –  –

Subordination   Original Reference –   –  –

Tax Deed   Certifi cate Number –   –  –

UCC    Original Reference –   –  –

UCO    Original Reference –   **  UCO Type*

*Mortgage and UCO Type Codes are shown in the next two tables.
**May contain collateral.

3.  Document Information

4.  Mortgage Type Codes

The codes listed below designate the type of mortgage indexed, depending on the form type 
used to prepare the mortgage.

Mortgage Type            Code

Conventional         CONV 

Equity Line          EQTY 

Farmers Home Administration     FMHA 

Federal Housing Administration     FHA 

Reverse        REV 

Veterans Administration      VA 
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5.  UCC/UCO Financing Statement Type Codes

The following codes designate types of UCC or UCO fi nancing statements, determined by the 
function of the document.

Statement Type             Code

Amendment         AMD 

Assignment         ASN 

Continuation         CONT 

Partial Release        PREL 

Release         REL 

Termination         TERM 
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County Suffi x Table
A plat that was recorded in one county may later become part of a different county, but may 
not be re-recorded in the new county. This table lists the suffi xes to use with the plat book 
number to fi nd such plats in ATIDS. Insert a hyphen between the number and the suffi x.

Example: To fi nd a plat in Broward County that was originally recorded in Miami-Dade County 
as plat book 2, page 17, use the suffi x D and search plat book 2-D, page 17 in Broward 
County.

Current County   Original County       Suffi x

Broward     Miami-Dade     D 

Broward     Palm Beach     P 

Flagler     St. Johns      J 

Indian River    Brevard      B 

Indian River    St. Lucie      S 

Martin     Brevard      B 

Martin     St. Lucie      S 

Pinellas     Hillsborough     H 

Santa Rosa     Escambia      E 
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                            USER PREFERENCES  Web ATIDS 
QUICK REFERENCE GUIDE 

 
 
HOW DO I ACCESS USER PREFERENCES? 

 Login to Web ATIDS. 
 From Main menu click on the “Preferences” link. 
 This will launch the User Preferences page in a new window. 

 
HOW DO I ENTER/UPDATE USER PREFERENCES? 

 Fill in the fields on the User Preferences page that you would like to have auto-populated in 
other transactions. 

 Click the “Save” button. 
 Click the “Exit” button. 

 
WHERE IS THE DATA I ENTERED IN USER PREFERENCES AUTO-POPULATED IN WEB 
ATIDS? 

 Search Menu: Delivery Options 
 Add a File: Ordered By 
 Policy Search and Order: Phone, Fax, Ordered By, Extension, Responsible Party & Deliver 

By 
 Order Documents Menu: Phone, Fax, Ordered By, Extension, Responsible Party & Deliver 

By 
 Order Branch Products: Ordered By, Responsible Party, Deliver By, Address, Phone, and Fax 
 Report Document Error: Requested By, Name, Phone, Extension 

 
WHAT IF I USE WEB ATIDS ON MORE THAN ONE COMPUTER? 

User Preferences are unique for each PC and FundNet ID.   
If you log into multiple PCs, you will have to setup your preferences on each PC. 
 

WHAT IF OTHER PEOPLE USE MY PC TO DO SEARCHES IN WEB ATIDS? 
User Preferences are unique for each PC and FundNet ID.   
Other people using your PC can set their own user preferences as long as they are using a 
different FundNet ID to access Web ATIDS. 

 
WHAT IF I CLEAR MY COOKIES? 

User Preferences are saved as a “Cookie” on your PC.   
If you clear your cookies, your User Preferences will be deleted. 
You can set up your User Preferences again the next time you log into Web ATIDS. 
 

WHAT IF THE “DELIVER BY” METHOD I CHOSE IN USER PREFERENCES IS NOT A VALID 
DELIVERY OPTION IN THE TRANSACTION I AM IN? 

Web ATIDS will default to an alternative option if no Deliver By method was set in User 
Preferences or if the method you chose is not a valid option. Deliver By method for Propel 
customers will default to ProPel. 
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